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Getting Started
Quick
start
guide
for
Reeltime

This article describes how to quickly get started with setting up Reeltime for a first evaluation. All
you need is a Mac with an Apple Silicon processor, macOS 14 or newer, and a webcam. In addition
to the minimal setup with a webcam, the article also covers a basic setup with a video I/O device.
Furthermore, the “first steps” sections walk you through some essential application features.

Trial
mode
and
adding
a
license
key

After starting the software for the first time, you can use it in trial mode for ten days. You can
extend your use at any time by entering a valid license within the License Window (Reeltime
Pro/Reeltime Lite > Licenses…). Note that the trial license version includes a visible watermark in
recordings and video outputs. For prepping and testing purposes you can also create a free test
license in your Pomfort account. The test license has the same limitations as a trial version and is
valid for 30 days. You can create a new test license at any time after a license has expired.

Sample
project
and
sample
footage

You can download a sample project and associated sample footage with dedicated menu items in
the help menu.

The sample project allows you to evaluate the software with a small library that contains recorded
clips from a real-world production.

The associated project media (= sample footage) is a Reeltime “media folder” that you can save on
your preferred directory and then configure it as the media path in the recording settings of your
project.

All media files are graded and encoded in ProRes Proxy (to keep the download size as small as
possible).

 

Minimum
setup
with
webcam
inputs

Configuring a webcam as input makes it easy to evaluate Reeltime without video I/O devices. If
you have two webcams at hand (i.e. an additional USB webcam), it’s beneficial as you can test the
group recording and playback functionality.

Within the slot manager (Reeltime Pro/Reeltime Lite > Slot Manager…), you can associate an input
video source, such as a webcam, with an input slot:

Open the slot manager’s input tab and select an existing input slot (e.g., slot “A”)
Choose the desired video input device under “Device”, for example, the internal “FaceTime
HD Camera” of your MacBook
Select another existing input slot (e.g., slot “B”) and configure a second webcam input
The webcams’ signals now appear in the live slot mode of your input slots “A” and “B”

Tip:Tip: Use the internal FaceTime webcam of your Mac notebook as the first input and the Use the internal FaceTime webcam of your Mac notebook as the first input and the
camera of your iPhone or iPad as the second camera. Your iPhone’s or iPad’s camera willcamera of your iPhone or iPad as the second camera. Your iPhone’s or iPad’s camera will
appear as a webcam automatically if you are connected with the same Apple ID as on yourappear as a webcam automatically if you are connected with the same Apple ID as on your
Mac.Mac.
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Slot manager with configured webcam inputs

You are all set for your first steps with recording and playback.

Add
local
streaming
outputs
(optional)

Even without I/O devices you can still evaluate how Reeltime Pro’s outputs can be configured. If
you have an iPhone or iPad at hand you can configure your output slots as local streams:

Open the slot manager’s output tab and select an existing output slot (e.g., “Out 1”)
Choose “Local Stream” as output type under “Device”
Select another existing output slot (e.g., slot “Out 2”) and configure a second local stream
By default the input slots “A” and “B” are set as sources for the output slots “Out 1” and
“Out 2”
You can change the source of an output slot by selecting the output slot in the main window
and changing the source within the slot settings.
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Setting the source of an output slot in the slot settings

To view the local streams on your mobile device, you can easily install the free “Reeltime
Viewer” companion app from the App Store by displaying the QR code in the local streaming
settings (Reeltime Pro > Settings… > Local Streaming)
To access the local streams on your iPhone or iPad, you must enter the password, which
you can view in Reeltime Pro’s local streaming settings
You can choose between different screen layouts. For example, you can choose a two-
viewer screen layout if you want to see the two local streams “Out 1” and “Out2” on your
iPhone.

7

Reeltime Pro 
Getting Started



Reeltime Viewer with a two-viewer screen layout on an iPhone

 

Read more about receiving local streams with the Reeltime Viewer companion app for iPhones and
iPads under Getting Started With Reeltime Viewer.

Basic
setup
with
a
video
I/O
device

Within the slot manager (Reeltime Pro/Reeltime Lite > Slot Manager…), you can associate the
input ports of your video I/O device with an input slot:

Open the slot manager’s input tab and select an existing input slot (e.g., slot “A”)
Choose the desired video input port under “Device”

The video format of the incoming video signal sets the video format of your device
automatically.
To receive the camera’s ANC metadata correctly and trigger recording based on the
record flag embedded in the SDI signal, ensure setting the appropriate camera type
and your preferred record trigger method.

Select another existing input slot (e.g., slot “B”) and configure a second input.
The video signals now appear in the live slot mode of your input slots “A” and “B”.
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Slot manager with SDI device configuration for an input slot

In the same way, you can associate the output ports of your video I/O device with an output slot:

Open the slot manager’s output tab and select an existing output slot (e.g., “Out 1”).
Choose the desired video output port under “Device”.
The video format of outgoing signals usually derives from the input and may not be editable.
However, with some devices, the output’s video format can be set manually.
Select another existing output slot (e.g., slot “Out 2”) and configure a second output.
By default the input slots “A” and “B” are set as sources for the output slots “Out 1” and
“Out 2”.
You can change the source of an output slot by selecting the output slot in the main window
and changing the source within the slot settings.

Quick
audio
setup
(optional)

If you want to include audio in your recordings, you can configure multiple audio inputs and mix
them down into one main audio track, which is then included in your video recordings:

Connect your audio
interface to your machine.
You can connect any audio source that is supported by macOS including embedded
audio channels from SDI signals via the drivers by AJA and Blackmagic.

Open Reeltime’s audio settings.
Enable at least one audio input by clicking on the speaker icon in the de table row.

The “Input Devices” list displays all audio devices that are connected to your machine.
You can enable all channels you want to use. Each channel has an individual volume
slider.

9

Reeltime Pro 
Getting Started



For audio
monitoring
and
playback you can choose an output device or select to use
system’s audio output device.
You can set the audio
source to follow the last selected input slot or library slot
automatically, or pin the the audio source to a specific input slot or library slot.
The audio
meters
in the toolbar visualize the active audio in green (for playback), blue (for
monitoring), and grey (if the audio is muted).
There are menu items (in the audio menu) and associated controller actions for muting
the
live
audio
or
all
audio and an associated global mute toolbar button.

Learn more about working with the main audio in the article Main Audio for Recording and
Playback.

Read how to set up audio devices in the article Setting Up Audio I/O Interfaces.

Recording
and
playback
with
input
slots
–
First
steps

Input slots are your “primary workbench” for recording and playback, as they allow you to monitor
your live signals, record clips, and playback the clips that were recorded. Consequently, input slots
have three different slot modes:

the Live mode – for monitoring and recording the live signal from a camera
the Playback mode – for playing back the recorded clips from the associated source camera
the Reference mode – for comparing live and playback signal with various layout option

There are dedicated buttons in the toolbar for switching all
input
slots
to
live/playback slot
mode.

Toolbar buttons for switching all inputs slot to “Live”/”Playback” slot mode

There are several ways to
create
single
recordings
and
TC-synced
group
recordings:

You can create a single
recording from a single camera’s live signal with the record button
in the individual slot card
You can create a timecode-synced
group
recording from all input slots

with the record button in the viewer controls (a sync info label indicates which slots are
currently synced and will be included in the group recording),
or with the “record all” button in the toolbar.
With a configured video I/O device by AJA and DELTACAST you can also trigger
recording based on the record flag embedded in SDI signals from professional
cameras.

Generally, all “armed” input slots are recorded in the upcoming group recording. However,
you can un-arm slots you want to exclude from the next group recording with the arrow
button beside the record button in the slot UI.
You can set multiple
in
and
out
ranges during recording for marking several actions within
one take.
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Input Slots in “Live” slot mode during group recording

You can now playback
your
recordings with several options in the playback slot mode of the
input slots:

New recordings appear in the clip library and are loaded automatically into their source slots
for instant playback

you can disable this behavior by checking “Disable automatic loading of new clips for
playback” in the recording settings

You can also load
a
synced
group
recording from the library into the source slots by
double-clicking a clip from that group
Alternatively, you can load
a
single
clip from the library into the currently selected slot with
the “Load Selected Clip into Current Slot” menu item
Ranges
playback
and
looping
options allow you to play back only the marked ranges in a
group or single clip
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Playback controls with editing options and enabled ranges playback and loop playback

To learn more about the individual features, read the article Recording and Playback.

Output
slots
–
First
steps

You can think of an output slot as a “showroom” for displaying the final product to your client.
With two configured output slots, you are all set to create “tailored views” by applying individual
filters to them. For example, you could apply a crop filter in the output slot “Out 1” and a metadata
overlay filter in the output slot “Out 2.”

Tailored views configured with individual filters per output slots

Additionally, the output routing options allow you to temporarily switch an output slot’s source
signal:
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Force
Slot
to
Follow
Live
Video – for forcing an output slot to always show the live signal of
its configured input source (= the input slot’s live slot mode)
Set
Slot
to
Follow
Selection – for automatically setting the input/library/composite slot that
is selected in the slot overview UI as the source for the output slot (“what you select is what
you get”)

Learn more about tailored views with video filters in the blog article How to Craft Tailored Views
With Reeltime Pro’s Slot System.

Library
slots
–
First
steps

When you recorded your files you can also check out the library slots. You can use a library slot as
a kind of “personal workbench” where you prepare requested actions or references for review
before anyone else actually sees them. Library slots are directly linked to the clip library, so you
can fill any library slot with any item you can select in the clip library.

Library
slots allow you to:

Find a specific clip by browsing the library with
the arrow down/up keys to auto-load
the
selected
clip
in
the
library
for instant
review and playback.

Compare shots or compare different play positions with
an independent
library
selection
per
library
slot, (e.g., different folder/bin/smart
group levels) and/or,
an independent playhead position per library slot, (e.g., two different ranges within the
same recording).

Two library slots with different selections in the clip library
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Composite
slots
–
First
steps

Composite slots serve as an “assembly zone” where you can create composites out of input and
library slots. Composite
slots allow you to:

Compose a view from multiple input and/or library slots with live and/or playback signals.
Choose from a range of layout
options for your compositing:

Side-by-Side (2×1): Create a side-by-side view of 2 slots (e.g., “A” and “B” camera)

Side-by-Side (3×1): Create a side-by-side view of 3 slots

There is an “Orientation” parameter in the composite slot’s filter settings that lets
you rotate the composite by -90° or +90° for vertical monitor installation (e.g., for
a composite of three images below each other).

2×2 Grid: Create a grid view of up to 4 slots (e.g., “A” and “B” camera and two library
slots “Lib 1” and “Lib 2”)
Swipe: Compare the content of two slots with a horizontal or vertical swipe

Overlay: Mix and overlay the content of two slots (e.g., to match the framing of two
shots)

Composite slot layouts

To learn more about working with slots, read the article Manage Video Signals With “Slots”.

Further
reading

The main window contains all primary controls for your daily tasks. To learn how to use the
individual features, read the article The main screen.

Reeltime’s innovative slots concept lets you flexibly manage your incoming and outgoing signals
and create tailored views for the different roles on set. To learn more about working with slots, read
the article Manage video signals with “Slots”.

You can create TC-synced group recordings or single recordings, set multiple in and out ranges
already during recording, and instantly play back all relevant ranges with various neat actions and
playback options. To learn more about the individual features, read the article Recording and
playback.

Reeltime’s clip library and metadata features enable you to reveal recorded clips in no time and let
you make use of all the metadata you applied during your project. To learn more about working
with the library and metadata, read the article Clip library and metadata.
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Reeltime’s versatile device integrations allow you to build a hardware setup optimized for your
production’s requirements. To learn more about supported devices and different setup options,
read the article Hardware setup options.
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Primary Features
The
main
screen

The main screen of Reeltime contains all the primary controls for operating the software.

You can, for example, control recording and playback, change the internal routing between slots,
apply and configure filters and composite layouts, fill in global metadata, and browse and maintain
the recorded clips in the clip library.

All controls in the main window can also be found in the main menu and can be triggered by
keyboard shortcuts or associated Stream Deck controller actions. Some elements offer a context
menu with additional options on a right-click (or option-click), for example, clips in the clip library.

Main View window layout

Main
view
layout

The main view provides all essential controls and UI elements you need for your video playback
related tasks. You can see all configured slots in a slots collection view, and you can control and
view the selected slot’s content in the main viewer. Furthermore, you can change the settings of
the selected slot and have access to all the clips you recorded in the clip library.

Toolbar:

The toolbar at the top of the interface is available in all window layouts and contains buttons for the
most common global actions. You can customize the toolbar with the contextual “Customize
Toolbar…” menu item (right-click / opt-click on toolbar) and drag and drop more actions into the
toolbar or change the position of the buttons.
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Slots
collection
view:

Slots are represented in the user interface as individual slot cards in the slot collection view on the
left of the main window. The slots are grouped by the slot types input slots, library slots,
composite slots and output slots. Library slots and composite slots can be added and removed
within the main window directly. For managing input slots and output slots and configuring devices
you can open the slot manager (via a toolbar button or options menu button the slot overview). In
the options menu you can also choose the slot card size. The slot cards have various labels and
indicators that help to keep track on the slot’s status. Learn more about slots in the article Manage
Video Signals With “Slots”.

Main
viewer:

The main viewer in the upper middle of the interface displays the image of the currently connected
slot and provides either playback controls in the playback slot mode or recording controls in the
live slot mode. Recording controls provide controls for triggering recording actions in a single slot
or timecode-synced groups of slots. Furthermore, recording controls allow setting multiple in and
out ranges while recording. Playback controls provide flexible options for playing back single
recordings or timecode-synced group recordings. Furthermore, playback controls allow navigating
within the recording/s and editing or adding in/out ranges. Most of the viewer controls apply to the
current group – for playback: all clips from the currently loaded group, for recording: all armed
input slots. The current group is indicated by the sync info label.

Slot
settings:

The slot settings in the config panel of the right-hand side of the interface display settings for the
currently selected slot based on its slot type. In an input slot you can configure the slot mode, add 
and edit filters, or inspect source, the loaded clip or the currently configured destinations. In a
library slot you can add and edit filters, or inspect the loaded clip, or the currently configured
destinations. In a composite slot you can choose from different composite layout modes, configure
source slots for the composite, and inspect or edit related filter settings. In an output slot you can
configure the source slot, set quick-routing options “Slot Follows Selection” and “Force Slot to
Live Video”, or add and edit filters, and inspect or edit related filter settings.

Global
metadata
(Main
view):

The global metadata tab in the config panel lets you inspect and edit metadata that is valid for all
currently configured input slots. Global metadata fields are slate info fields such as scene, shot and
take, production info fields such as location and crew unit, or general info fields such as time and
date. The global metadata is stored together with the slot specific metadata such as clip name and
timecode in each clip entry of the clip library.

You can configure the global metadata field with the options menu button to include only fields
required by your production.

Clip
library:

The clip library contains all recordings made throughout a project. It offers various tools to reveal a
required clip quickly. A library outline allows you to sort recordings into folders and bins manually.
The smart groups tab lets you outline and filter the library with flexible hierarchies based on the
existing clip metadata (e.g., Scene/Shot/Take). You can view clips in a tabular form in the clips
table, which displays all clips and their metadata in customizable column layouts. The collection
view displays each clip with a large thumbnail and provides a visual search with a skimming
mechanism, allowing you to find a specific action within a clip quickly. A text search allows you to
search for specific terms to quickly display matching clips in the clips table or collection view.
Furthermore, an info tab shows the metadata of one or more selected clips in a detail view and
allows you to inspect and (multi-)edit the clip metadata. To learn more about the clip library, read
the article Clip Library and Metadata.
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Multi
view
layouts

Apart from the main view window layout, there are also multi view layouts that offer a reduced set
of UI elements and represent each slot in its own viewer. Multi view layouts are optimized to ensure
efficient work also on small screen sizes.

Multi View window layout

Slot
multi
viewers:

The slot multi viewers work the same way as the main viewer but display each currently configured
slot in its own viewer window. There are dedicated multi view layouts for the slot types: input slots,
library slots, and output slots. Multi view layouts automatically adapt their sizing and grid layout
depending on the number of configured slots. The multi view layouts can display up to 3×3 (9
slots).

Global
metadata
(Multi
view):

The global metadata panel in the multi view layouts works similarly to the global metadata panel in
the main view layout but uses a horizontal layout with larger text boxes. You can increase the
values in a text box with the arrow up/down keys and navigate back and forth between fields with
a tab or shift tab.

Manage
video
signals
with
“Slots”

Slots are a flexible and transparent way to manage and route live and playback video signals to
various destinations.

Each slot is a container for either a signal input, video playback, video output or a composite of
other slots. You can connect slots to each other to create internal video routing setups from simple
to complex structure.
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Slots are represented in the user interface as individual slot cards in the slot overview on the left of
the main window. Slots are grouped in the slot overview by type:

Slot
types are
input slots,
library slots,
composite slots and
output slots

Slots of the “Input Slot” type can have further modes. Slot types and slot modes are explained in
more detail below.

Input
slots

Input slots are your “primary workbench” for recording and playback, as they allow you to monitor
your live signals, record clips, and playback the clips that were recorded.

Input slots allow you to:
Associate your input slots with the video inputs installed on your system (such as SDI
input ports) in order to monitor, record and distribute all your incoming signals.
Play back the clips that were recorded in the associated source input slots.
Consequently, input slots have three different slot modes:

the Live mode – for monitoring and recording the live signal from a camera,
the Playback mode – for playing back the recorded clips from the associated
source camera (recorded clips are loaded into their source input slot by default),
the Reference mode – for comparing live and playback signal with various layout
options:

Side-by-Side: For creating a side-by-side view of the slot’s live and
playback signal.
Swipe: For comparing the content of the slot’s live and playback signal
with a horizontal or vertical swipe.

Overlay: For creating an instant mix and overlay composite of the slot’s
live and playback signal, (e.g., to match the framing).

Input Slots in “Live” slot mode during group recording
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There are dedicated buttons in the toolbar for switching all input slots to live/playback slot
mode, (e.g., switch all input slots to live lets you quickly resume to the live signal if shooting
continues).

Toolbar buttons for switching all inputs slot to “Live”/”Playback” slot mode

Output
slots

You can think of an output slot as a “showroom” for displaying the final product to your
client. Output slots allow you to:

Associate your output slots with the video outputs installed on your system (such as SDI
output ports) in order to distribute the signals from input slots, library slots, and composite
slots to various destinations.
You can configure the source of an output slot in the slot settings, which are located on the
right-hand side of the main window. As a source, you can configure any available input,
library, or composite slots.
Alternatively, you can change the source for the selected output slot with dedicated Slot >
Change Source of Selected Output Slot menu items, or the associated Stream Deck
controller actions.
Additionally, the output quick routing options allow you to temporarily switch an output slot’s
source signal:

Force Slot to Follow Live Video – for forcing an output slot to always show the
live signal of its configured input source (= the input slot’s live slot mode).
Set Slot to Follow Selection – for automatically setting the
input/library/composite slot that is selected in the slot overview UI as the source
for the output slot (“what you select is what you get”).

You can create a filtered, composited view tailored for the associated watcher or specific
use case with individual filters and appearance settings and flexible routing options (e.g., the
director wants to see a cropped image from camera A, while Script Continuity wants to see
an un-cropped side-by-side view of camera A and B).

Output slot viewer and settings
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Managing
input
slots
and
output
slots
in
the
slot
manager

You can add or remove input and output slots and associate them with your connected devices in
the Slot Manager window (e.g., via the button from the main window’s toolbar)

Toolbar button for opening slot manager

You can flexibly add up to 4 input/output slots (3 inputs + 1 output or 2 inputs + 2 outputs or 1
input + 3 outputs) with Reeltime Lite

You can add up to 3 input slots and up to 6 output slots with the Reeltime Pro 3-Channel option

You can add up to 6 input slots and up to 9 output slots with the Reeltime Pro 6-Channel option

Within the slot manager, you can associate input sources (e.g., SDI input ports) from any
compatible device that is connected to your machine with an input slot and, in the same way,
destinations (e.g., SDI output ports) with output slots:

The video format of the incoming video signal sets the video format of your device
automatically.
The video format of outgoing signals usually derives from the input and may not be editable.
However, with some devices, the output’s video format can be set manually.
To receive the camera’s ANC metadata correctly and trigger recording based on the record
flag embedded in the SDI signal, ensure setting the appropriate camera type and your
preferred record trigger method
In rare cases, you can also change the decoding levels from legal to full, for example, if you
receive an ungraded signal from a Sony camera that outputs an SDI signal in extended
range.
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Slot manager with SDI device configuration for an input slot

Slot
setups

If you need to frequently switch between various setup configurations, you can save and restore
“slot setups”. A slot setup includes all configured slots, including the configuration of input/output
devices and streams.

You open the dedicated Slot Setups window via the Reeltime Pro / Reeltime Lite > Slot Setups…
menu item or a Slot Setups…  button at the top right corner of the slot manager. The Slot Setups
window allows you to save your current setup, restore a previously saved setup, rename,
duplicate, and delete slot setups.

Library
slots

You can use a library slot as a kind of “personal workbench” where you prepare requested actions
or references for review before anyone else actually sees them. Library slots are directly linked to
the clip library, so you can fill any library slot with any item you can select in the clip library. Library
slots allow you to:

Find a specific clip by browsing the library with
the arrow down/up keys to auto-load the selected clip in the library for instant review
and playback
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Compare shots or compare different play positions with
an independent library selection per library slot, (e.g., different folder/bin/smart group
levels) and/or
an independent playhead position per library slot, (e.g., two different ranges within the
same recording)

You can add up to 2 library slots with the Reeltime Lite

You can add up to 6 library slots with the Reeltime Pro 3-Channel option

You can add up to 9 library slots with the Reeltime Pro 6-Channel option

Composite
slots

Composite slots serve as an “assembly zone” where you can create composites out of input and
library slots. Composite slots allow you to:

Compose a view from multiple input and/or library slots with live and/or playback signals:
Choose from a range of layout options for your compositing (similarly to the reference mode
of the input slots):

Side-by-Side (2×1): Create a side-by-side view of 2 slots

Side-by-Side (3×1): Create a side-by-side view of 3 slots

There is an “Orientation” parameter in the composite slot’s filter settings that lets
you rotate the composite by -90° or +90° for vertical monitor installation (e.g., for
a composite of three images below each other).

2×2 Grid: Create a grid view of up to 4 slots
Swipe: Compare the content of two slots with a horizontal or vertical swipe

Overlay: Mix and overlay the content of two slots (e.g., to match the framing of two
shots)

Tip:Tip: To play back multiple library slots from their current playhead position simultaneously, To play back multiple library slots from their current playhead position simultaneously,
you can use the “Toggle Playback in All Library Slots” menu item or the associated Streamyou can use the “Toggle Playback in All Library Slots” menu item or the associated Stream
Deck controller action. There is also a dedicated “Play All Library Slots” toolbar button thatDeck controller action. There is also a dedicated “Play All Library Slots” toolbar button that
you can add to your toolbar layout when customising the toolbar (right-click or option-click onyou can add to your toolbar layout when customising the toolbar (right-click or option-click on
the toolbar).the toolbar).
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Composite slot layouts

Combine a composite slot’s source selection with the input slot modes
“Live/Playback/Reference”, “Switch All Inputs Slots to Live Video/ to Playback”, and the
output routing option “Force Slot to Follow Live Video”, (e.g., you can let the composite slot
always show the signal of the active input slot mode, or force it to show always the live signal
of the configured input slots)
Auto-configure the input source for a composite slot using the Auto mode in the composite
slot settings by letting you configure the source with (option-click) on the desired input slots

Arm and record composite slots together with input slots, (e.g., to record a green screen
compositing preview together with your foreground and background)

Composite slot viewer and settings with side-by-side layout configured

In a composite slot’s viewer controls, you can switch between recording and playback controls.

Furthermore, you can toggle between the composite’s global controls and the controls of the
individual sources. You can cycle through those individual controls by clicking on the composite
slot’s slot name label or using the menu item “Cycle Viewer Controls of Composite Slot” or the
associated Stream Deck controller action.

In addition to the composite features, you can choose from various video filters to create tailored
views for the different watching roles on set. Read more about working with filters in the article
Create Tailored Views With Video Filters.
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You have 1 composite slot in Reeltime Lite

You can add up to 2 composite slots with the Reeltime Pro 3-Channel option

You can add up to 4 composite slots with the Reeltime Pro 6-Channel option

Highlight
connected
slots

You can visually highlight all slots that are connected to the currently selected slot with the
“Connected Slots” toolbar button or the associated “Highlight Connected Slots” menu item and
Stream Deck controller action. 

This way, you can see the internal routing between your slots – from input slots/library slots
through composite slots to output slots (e.g., for seeing quickly which source/s are configured to
an output slot).

 

Connected slots toolbar button

Recording
and
playback

Reeltime provides a highly performant video pipeline and a modern recording and playback engine
allowing for simultaneous TC-synced group recording of up to six camera signals (in HD & 4K
resolution at up to 60 fps).

Create
recordings

There are several ways to create single recordings and TC-synced group recordings:

You can create a single recording from a single camera’s live signal with the record button in
the individual slot card, the associated menu item, or Stream Deck controller action.
You can create a timecode-synced group recording from all currently armed input slots and
composite slots

with the record button in the viewer controls (a sync info label indicates which slots are
currently synced and will be included in the group recording)
or with the “record all” button in the toolbar, or the associated menu item, or Stream
Deck controller action.

Note:Note: You can add the “Connected Slots” toolbar button by customizing your toolbar; see the You can add the “Connected Slots” toolbar button by customizing your toolbar; see the
article Customizable Toolbar.article Customizable Toolbar.

Note:Note: Interlaced video formats are not supported Interlaced video formats are not supported
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Generally, all “armed” input slots (and composite slots) are recorded in the upcoming group
recording. However, you can un-arm slots you want to exclude from the next group
recording with the arrow button beside the record button in the slot UI.

You can enable and disable recording for a slot by clicking the arrow button beside the
record button in the slot UI. When set, the slot is “armed” for the upcoming group
recording. For example, if you shoot one scene with three cameras and the next scene
will only be shot by two cameras, you can keep your third input slot and un-arm the
third slot for that scene.

You can set multiple in/out ranges during recording for marking several actions within one
take. You can annotate and rate in/out ranges already during recording, or delete ranges in
the in/out ranges and markers tab. Refer to the dedicated knowledge base articles: In/Out
ranges and markers with annotations and In/Out ranges and markers tab.
The clip name and SMPTE timecode that is embedded in SDI camera signals are stored
together with the global metadata for each recorded clip (SMPTE timecode only works with
the “Original Timecode” recording settings).
If you want to abort an ongoing recording, you can cancel recordings via dedicated menu
items, keyboard shortcuts, or Stream Deck controller actions, either for the selected slot or
for all recordings. Canceled recordings do not appear in the library, and their media can
either be moved to the trash or deleted permanently. You can set your preferred behavior in
the recording settings.

Recording controls with multiple in/out ranges

Load
and
play
recorded
clips

There are several ways to load and playback single clips or TC-synced group recordings:
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You can load a synced group recording from the library into the source slots by double-
clicking a clip from that group. Alternatively, you can use the Library > Load Group of
Selected Clip into Source Slots menu item, or the associated keyboard shortcut, or Stream
Deck controller action. There is also a contextual menu item for each group recording in the
library.
You can load a single clip from the library into the currently selected slot with the Library >
Load Selected Clip into Current Slot menu item,or the associated keyboard shortcut, or
Stream Deck controller action. There is also a contextual menu item for each clip in the
library.
By default, new recordings are loaded into their source slots for instant playback. You can
disable this automatic behavior by unchecking “Automatically load new clips for playback” in
the “Behavior After Recording” box of the recording settings.

In the same settings, you can specify whether the new recording should start playing
back automatically (immediately after loading, or after a short delay).

The Playback > Play Last Recording menu item, or the associated keyboard shortcut or
Stream Deck controller action, lets you load and play the last recording at any time.

Playback
controls

There are several ways to control the playback of clips:

Industry-standard “JKL” keyboard shortcuts let you navigate conveniently within clips:
Toggle playback (Space)
Play forwards/backward (L/J)
Play faster (press L/J multiple times to increase playback speed to 2x, 4x, 8x, 16x, 32x
and 64x)
Play slower (Shift-L/Shift-J, and press multiple times to decrease playback speed to
1/2x, 1/4x and 1/8x)
Step to next/previous frame (hold K and press L or J)

Various controls and actions let you navigate through in/out ranges and markers:
Jump to next/previous in/out point (cycle through)
Jump to next/previous marker (cycle through)
Learn more about working with in/out ranges and markers by reading the knowledge
base article In/Out ranges and markers with annotations.

Ranges playback controls allow you to play back only the marked ranges in a group or single
clip:

Playback the entire clip
Playback the current range
Playback all ranges

Loop playback controls allow you to loop a playback (also in combination with ranges
playback):

Loop
loops from the start until the end of a clip or range (in combination with ranges
playback).

Ping Pong
loops alternating forward and backward from the start until the end of a clip or
range (in combination with ranges playback).

Tip:Tip: You can control playback with “JKL” controls also with a Stream Deck controller. The You can control playback with “JKL” controls also with a Stream Deck controller. The
Stream Deck buttons behave the same as the keyboard shortcuts. For example, pressing theStream Deck buttons behave the same as the keyboard shortcuts. For example, pressing the
“L – Forward” button once starts playback forward at normal speed, pressing the button a“L – Forward” button once starts playback forward at normal speed, pressing the button a
second time speeds up playback forward to 2X speed, etc.second time speeds up playback forward to 2X speed, etc.
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Playback controls with editing options and enabled ranges playback and loop playback

Playback
speed

You can increase or decrease the playback speed with JKL commands (see above), or you can set
a playback speed multiplier from various factor presets or enter a custom factor (e.g., for
simulating a slow-motion shot).

A playback speed badge in the viewer controls indicates the current playback speed. By clicking
on the playback speed badge, you open an overlay displaying the available preset factors and a
field for entering a custom factor.

Setting the playback speed in the viewer controls

Alternatively, you can also switch to a desired playback speed multiplier via the Playback > Set
Playback Speed menu items or the associated Stream Deck controller actions.

Audio
recording
and
playback

Reeltime can receive audio input signals from multiple connected audio devices and record the
audio in sync with your video recordings. The input signals are mixed down to one main audio
track, which you can include in any recordings, and simultaneously output to one audio output
device for live audio monitoring or audio playback.

Here’s a quick overview on working with audio recording and playback:
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The audio settings allow selecting multiple
audio
input
devices and mixing their channels
into one dual-mono audio output signal for recording and monitoring.
For audio monitoring and playback you can choose an output
device or select to use
system’s audio output device.
You can set the audio
source to follow the last selected input slot or library slot
automatically, or pin the the audio source to a specific input slot or library slot.
The audio
meters
in the toolbar visualize the active audio in green (for playback), blue (for
monitoring), and grey (if the audio is muted).
There are menu items and controller actions for muting
the
live
audio
or
all
audio and an
associated global mute toolbar button.
You can add an audio
delay to the audio recording to keep it in sync with the video signals.

Learn more about working with the main audio in the article Main Audio for Recording and
Playback.

Read how to set up audio devices in the article Setting Up Audio I/O Interfaces.

Clip
library
and
metadata

Reeltime stores all your recordings in a comprehensive clip library including clip-based and global
metadata. The clip library and its underlying media file management (media folders and record
folder) is project-dependent so that you can have a dedicated library with individual media file
management for each of your shoots.

Manage
clips
and
stills
in
the
clip
library

Over the course of a project the clip library grows to a comprehensive log of all shots and
rehearsals that can be accessed anytime for review.

Adding
clips
to
the
library:

You can add clips by creating recordings manually or automatically using the auto-record
mechanism (e.g. following the record flag in SDI signal’s ANC metadata). 

You can add stills from the currently selected slot’s signal (live or playback mode), all armed slots
(live mode), or all loaded group clips st the current playhead position (playback mode).

Additionally, an “Import Media…” menu item in the library menu lets you import QuickTime movies
in a ProRes codec or still images (in jpeg, png, tiff, heif and heic) as a reference. 

All clip entires combine the clip specific metadata (such as clip name and timecode from the ANC
metadata in the video signal) with the currently filled in global metadata fields which helps later to
find clips using the smart groups and/or the text search, etc.

A “Duplicate” contextual menu item in the clip library allows for duplicating the selected clip(s)
and/or still(s).

Loading
clips
for
playback:

By default recorded clips are automatically loaded for playback into the associated source slot
when recording has stopped. If you wish you can disable this behaviour in the recording settings.

Additionally, you can also load a clip manually by double-clicking the clip in the library:

If the clip is a single recording the clip is loaded into the currently selected slot
If the clip is in a group the whole group is loaded into its associated source slots for TC-
synced group playback, (e.g., the clip from camera A into slot A, the clip from camera B into
slot B, etc.)
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Using the “Load Selected Clip into Current Slot” menu item or controller action you can also load a
single clip form a group into the currently selected slot.

Managing
groups:

You can select the whole group of a clip by option-clicking one clip of the group, (e.g., to edit the
metadata for all selected clips in the info tab, see below). Furthermore, you can remove a clip from
a group or merge clips into a group, (e.g., if you finished recording in one of the slots accidentally
and then restarted recording a second “part” of a clip you will need to add the second part to the
group). 

Applying
clip-specific
metadata
and
global
metadata

Each recording comes with clip-specific metadata fields such as timecode, clip name and camera
(slot character). Global metadata are metadata fields that are valid for all recordings in a group, for
example slate info fields (scene, shot, take, etc.) and production info fields (shooting day, location,
crew unit, etc.).

Clip-specific metadata fields are usually auto-populated based on the metadata in the SDI signal
and the slot configuration.

You can fill-in the global metadata fields in the global metadata panel. There is a vertical panel in
the upper right hand side of the main view layout or a horizontal panel between the toolbar and
viewers in the multi-view layouts. By default the take fields is increased automatically after
recording stopped (except for single recordings triggered directly from the slot card). You can
disable the automatically increasing for the take field in the recording settings.

Note:Note: Groups are synced through their SMPTE timecode track. When merging groups make Groups are synced through their SMPTE timecode track. When merging groups make
sure the timecode of the clips are overlapping.sure the timecode of the clips are overlapping.
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Global Metadata panel in main view window layout

You can set your preferred behaviour (e.g., how the scene field should increment) in the slating
settings.

The “Take” field is increased automatically after a recording stopped (you can disable this
behaviour by checking “Disable increase of take number after recording has stopped”)

Rehearsal
mode:

You can activate the “rehearsal mode” to apply a customizable rehearsal prefix to the take field of
the upcoming recording(s). The default rehearsal prefix is “R”, however, you can change it to your
preferred prefix in the slating settings.

You enable the rehearsal mode via the Slot > Enable Rehearsal Mode menu item, or the associated
Stream Deck controller action. Alternatively, you can toggle the rehearsal mode on/off with the
dedicated “R” global toolbar button.

The active rehearsal mode is also indicated by the amber-colored color bar in the input slots and
the amber-colored record button during recording.

Additionally, all recordings made during rehearsal mode get assigned the amber-colored clip label
“Rehearsal” (the automatic behavior can be changed in the library settings under “Automatic Label
Assignment”).
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Clip
labels:

You can assign a colored clip label to any media item in the library. The label names are
customizable in the library settings under “Label Names”. The label settings are project-
dependent. By default, labels are assigned automatically for the following labels:

Movie recordings > “Recorded Takes” (red label)
Recordings of rehearsals > “Rehearsal” (amber label)
Created stills > “Reference” (yellow label)

Composite recordings > “Composite Recording” (violet label)

Imported media > “Imported Media” (grey label)

The automatic behavior can be changed in the library settings under “Automatic Label
Assignment”. The automatic label assignment settings are project-dependent.

The
clip
library’s
UI
elements

The clip library has multiple UI elements helping you the manage and inspect your clips in your
preferred appearance and structure.

Clip
library
outline
(Folders
and
Bins):

Clips always reside in bins, and bins can be grouped in folders. Folders and bins can be used to
give your project a logical structure by for example grouping shots in shooting days, cameras,
units, or scenes. You can create bins and folders with the corresponding buttons above the clip
library. Drag and drop bins for grouping bins in folders or reordering bins and folders. You can hide
the clip library outline column (e.g., if you prefer to browse the library only using smart groups)

Smart
groups:

There is an advanced “Smart Groups” view accessible from the clip library window, that displays a
hierarchical structured outline of the currently selected folder level of the shot library. Smart groups
are auto-generated based on clip metadata. You can define the hierarchy levels for the outline in
an option menu, that provides the metadata fields “Season”, “Episode”, “Flagged”, “Label”, “Crew
Unit”, “Shooting Day”, “Scene”, “Shot”, “Take”, “Camera”, “Caption”, “Location” and “Rating” to
choose from. You can also choose from predefined smart group layouts or save and apply custom
layouts. You can hide the smart groups column, (e.g., if you want to the clip library outline instead
or need more space to view your table content or collection view content.)

Note:Note: Smart groups are pre-filtered by the selected folder/bin in the shot library sidebar. When Smart groups are pre-filtered by the selected folder/bin in the shot library sidebar. When
you want to view all available items in the library, make sure to select the “Library” homeyou want to view all available items in the library, make sure to select the “Library” home
folder in the shot library sidebar.folder in the shot library sidebar.
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Library with “Scene” > “Shot” > “Take” smart groups

Clips
table:

The clips table displays the clip entries of the currently selected bin or folder in the clip library.

A clip’s metadata is displayed as columns that you can sort by or edit clicking into the field. You
can change the list’s shown columns with the options menu on top of the clips table. You can also
reorder the table columns by dragging them. If you want to use multiple column layouts for
different use cases or projects you can save a column layout and/or restore one of the saved
column layouts. Furthermore, a text search field lets you display only clip entries that match the
currently entered text string.

Clips
collection
view:

The clips collection view is an additional view in the clip library that visually represents clips with a
large thumbnail, the clip’s name and rating and flagging properties. By hovering over a thumbnail
you can skim through the clip’s content and load the clip at the current skim-head position by
double clicking. You can use the text search field to display only clip entries that match the
currently enters text string.

Info
tab:

The info tab in the lower right-hand side of the interface lets you inspect and edit the metadata of
the selected clip in the clip library. If you select multiple clips you can also inspect fields with
matching values or multi-edit metadata fields for all selected clips at once.

In/Out
ranges
and
markers
with
annotations

Reeltime allows you to annotate sections or specific frames in recordings by setting in/out ranges
and/or markers with info. In the clip library, you can search through in/out ranges and marker info
to reveal the annotated sections and positions.

Tip:
Tip:
You can use the skimming mechanism to find a specific action within a clip. By double-You can use the skimming mechanism to find a specific action within a clip. By double-
clicking you can directly load the selected clip or group at the skim head’s position to startclicking you can directly load the selected clip or group at the skim head’s position to start
playback at the intended position.playback at the intended position.

Tip:
Tip:
Select a whole group with option-click on on of the clips and use the info tab to editSelect a whole group with option-click on on of the clips and use the info tab to edit
metadata such as rating or flagging for all clips in the group at oncemetadata such as rating or flagging for all clips in the group at once
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In/Out
ranges
vs.
markers

In/out ranges are interlocked with Reeltime’s playback and loop mechanism. Hence, in/out ranges
are ideal to mark the sections that are relevant for playback reviews, e.g. set an in/out range for
each action within a take.

Markers are primarily designed to annotate a specific frame position or sections that you may need
to revisit later for reference, QC-related topics, continuity issues, etc., e.g., you can set a continuity
marker to note a continuity issue you want to share with the script supervisor or set a marker range
(with an out-point) for a temporary event that is relevant for QC, e.g., if the boom microphone is
visible for some time during the shot. 

In group recordings in/out ranges always apply to all clips in the group. Markers can apply to the
whole group (group markers) or to the individual clips of a group (single markers).

Markers and marker ranges (markers with an in and out point) can overlay in/out ranges and other
markers, e.g., you can set a continuity marker and QC marker at the exact same frame. In/out
ranges, on the other hand, can not be set on top of each other.

The differences between in/out ranges and markers in summary:

In/Out
ranges

Interlocked with playback and loop mechanism
Ideal for marking sections relevant for playback reviews
Used to set ranges for each action within a take
Apply to all clips in group recordings
Cannot overlap with other in/out ranges

Markers

Designed for annotating specific frame positions or sections for later reference
Used for QC-related topics, continuity issues, and temporary events
Can be set as group markers or single markers in group recordings
Can overlay in/out ranges and other markers at the same frame or section

Set
in/out
ranges
with
annotations

You can set in/out ranges to mark the relevant sections within a take (e.g., set one in/out range for
each action):

In/out ranges are deeply interlocked with Reeltime’s playback functions and let you
set multiple in/out ranges during recording or playback, 
enable the ranges playback mode to play back only the marked range(s) in the clip,
combine the ranges playback also with looping to loop through only the marked
range(s) in the clip,
edit in/out ranges in playback mode to fine-tune their in and out points or add new
ranges,
apply a rating and note to each in/out range.

Tip:Tip: Tag your in/out ranges with a rating and/or a note to find a relevant action quicker (e.g., Tag your in/out ranges with a rating and/or a note to find a relevant action quicker (e.g.,
set a 5-star rating for the best action in a take)set a 5-star rating for the best action in a take)
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Set
markers
with
annotations

You can set markers to annotate a relevant frame position or a section for reference, continuity,
QC, or other purposes:

Markers allow you to mark frame positions or sections 
during recording or in playback mode,
for an individual recording or all recordings of the group,
with eight colored marker types, that you can customize within the library settings,
and with a rating and note for each marker.

The thumbnail frame is a special kind of marker that allows you to set a clip’s frame position
for visual representation in the library (by default, the middle of the clip). Like with other
markers you can set the thumbnail frame position for an individual recording or all recordings
of the group.

A dedicated list view lets you inspect all in/out ranges and markers of the current recording/loaded
clip and edit their info. Read more about the in/out ranges and markers list view in the article:
In/Out Ranges and Markers Tab

In/out ranges and markers in viewer control and dedicated in/out ranges and markers tab

Tip:Tip: You can copy/cut and paste markers – along with their info – to another position or clip,  You can copy/cut and paste markers – along with their info – to another position or clip, 
e.g., to reuse markers with specific information as templates for frequently occurring usee.g., to reuse markers with specific information as templates for frequently occurring use
cases. Additionally, you can copy and paste markers with their details into a text document.cases. Additionally, you can copy and paste markers with their details into a text document.
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Find
annotated
in/out
ranges
and
markers
in
the
library

The clip library’s text search includes searching through the complete in/out ranges info and
marker info for the optimal retrievability of your annotated sections and frames. 

In the library’s detail view, there is a tab displaying the selected clip’s marker and in/out range
information. A reveal button lets you load clips directly at the marked position.

Create
tailored
views
with
video
filters

In addition to Reeltime’s composite features (available in composite slots and the reference mode
of input slots), you can choose from various video filters to create tailored views for the different
watching roles on set. For example, the Director may prefer a clean image where the camera’s
metadata HUD is cropped, while for Script/Continuity seeing the camera’s metadata is essential
and in addition they would like to see a metadata overlay with the camera name and the slate info.
You can flexibly add filters to your slots to serve everyone’s needs.

Video
filters: The application provides the following video filters for input slots, library slots,
or output slots:

Crop with offset and rotation parameters and an auto-detection to crop out the black-
bordered status info from a camera HUD
Flip for flipping the image horizontally/vertically
Transform with scale, rotation, and offset parameters, e.g., for re-positioning cropped
layers of a compositing
Anamorphic
Desqueeze with various lens squeeze factors for de-squeezing signlas
shot with anamorphic lenses
Metadata
Overlay with parameters for the metadata fields Camera, Slate Info, Slot
Mode (Playback/Live), Tally State (Record/Live/Play/Pause), Clip Name, and Timecode
Tally with various indicator options, and style and size parameters allows to apply an
on-screen tally to indicate the current operation state (Record, Record Rehearsal, Live,
Play, Pause) in various styles
Image
Overlay with opacity, scale, offset parameters, e.g., for adding a watermark or
overlaying frame lines from a PNG
LUT for loading a 3D LUT in a .cube format, e.g., for applying a look if you receive an
ungraded signal

Tip:
Tip:
Consider if it makes sense to apply a filter to an input slot or an output slot. For example,Consider if it makes sense to apply a filter to an input slot or an output slot. For example,
if you want to ensure that everyone sees a look from a LUT filter, you can apply the filter to theif you want to ensure that everyone sees a look from a LUT filter, you can apply the filter to the
input slot. However, if only some watchers want to see metadata overlays, apply the metadatainput slot. However, if only some watchers want to see metadata overlays, apply the metadata
overlay filter individually per output slot.overlay filter individually per output slot.
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Tailored views configured with individual filters per output slots

Chroma
key
and
compositing
filters: The application provides the following chroma key
and compositing filters for input slots, library slots, or output slots:

Keyer with various matte and fill control parameters and a spill suppression allows
real-time removal of greenish or blueish areas from live or playback signals and
creating a transparent, isolated foreground for compositing (via the overlay layout
mode of a composite slot)
Color
Adjust with basic color adjustment parameters such as contrast, temperature
and saturation (e.g., for balancing the foreground and background of a compositing)
Blur adds a Gaussian blur (e.g., for softening the background plate of a compositing)

Filter
Settings:
You can inspect and edit filter settings in the settings tab of each slot.
You can adjust the values in the filter setting text fields using the arrow up and down
keys on your keyboard.
You can reset a filter’s parameter to its default value by double-clicking on the
parameter’s label.
There are consistent layout options in composite slots and the reference mode of input
slots (Side-by-Side, Swipe, Overlay).
Filter settings of all currently connected slots are accumulated (for example, an output
slot shows filter settings for itself but also for the connected input slot(s) under
“Related Filter Settings”).
Dedicated menu items and controller actions allow you to copy and paste filters and
their settings between slots or remove all filters from the selected slot.
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Configured filter settings with crop and image overlay filter

Green
screen
compositing

Reeltime Pro allows you to apply a real-time chroma key filter to any live or playback signal and
composite the isolated image as a foreground with a background plate that you imported or
recorded into the clip library and loaded into a library slot. This article describes creating a green
screen compositing with the keyer filter and the overlay layout option in the composite slot and
fine-tuning your composite with additional filters such as basic color adjustments and a blur filter.

1.
Apply
a
keyer
filter

If you want to key one or more incoming live signals, you can apply the “Keyer” filter directly in the
input slots.

The “Keyer” filter uses a very efficient method to remove green or blue areas in the image signal,
which allows it to be applied in real-time without introducing additional latency.

For the best outcome, you can customize your key with dedicated viewing modes and a range of
“Matte Control”, “Matte Fill” and “Spill Control” parameters:

Note:Note: The “Keyer” filter is designed to work only within the green or blue color ranges. If you The “Keyer” filter is designed to work only within the green or blue color ranges. If you
select another color, the filter may not have the desired effect.select another color, the filter may not have the desired effect.
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Mode: Switch between the viewing modes:
Preview (=filtered image) and
Screen (transparent areas in black / non-transparent areas in white)

Channel: Choose the desired target color channel for your key (green or blue)
Color
picker: Pick a color in the area of the green or blue screen
Noise
level: Increases the amount of pixels included in the transparent area
Details
level: Retains more details in the non-transparent areas
Amount: Increases the overall red/green (or orange/blue) color difference mask
Black
fill: Increases the transparent areas of the final mask
White
fill: Increases the non-transparent areas of the final mask
Spill
level: Neutralizes color spill in the overall image

Follow these steps to apply a chroma key to your green screen live signal:

Select the input slot with the green screen signal.
Choose the “Keyer” filter from the “Add Filter” button menu.
Use the color picker to pick a greenish color in your green screen background.
You can switch to the “Matte” viewing mode to inspect the key.
Refine your key with the “Matte Control”, “Matte Fill” and “Spill Control” parameters until
your keyed area is black and the foreground is white.
Switch back to “Preview” viewing mode to inspect your final key.

You are currently viewing a placeholder content from Vimeo. To access the actual content, click
the button below. Please note that doing so will share data with third-party providers.

More Information

Unblock content
Accept required service and unblock content

The keyer filter will automatically be saved in the upcoming recording. You can change the filter
parameters anytime when loading the clip into the playback mode of an input slot or a library slot.
Ensure that you save the filter settings when you want to keep your adjustments (with the “Save”
button in the filter settings or the associated menu items or Stream Deck controller actions).

2.
Import
background
plates

You can import clips as background plates into your project’s clip library via the movie import
function. Note that imported movies need to be in a ProRes codec (as Reeltime Pro uses the built-
in ProRes hardware acceleration of Apple Silicon processors to achieve the best performance).

Follow these steps to import your background plates:

Select a folder and bin in your clip library into which you want to import your background
plates.
Choose “File” > “Import Media…” and select the movies you want to import and proceed.
Create a library slot or select an existing library slot.
Load the imported movies into the library slot and find the most appropriate background
plate.

Tip:Tip: There are menu items and Stream Deck controller actions for copying and pasting your There are menu items and Stream Deck controller actions for copying and pasting your
filter settings from one slot to the other if you have more than one camera that captures thefilter settings from one slot to the other if you have more than one camera that captures the
green screen.green screen.
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When you find the desired background, start playback and enable loop playback if it makes
sense.

You are currently viewing a placeholder content from Vimeo. To access the actual content, click
the button below. Please note that doing so will share data with third-party providers.

More Information

Unblock content
Accept required service and unblock content

3.
Composite
the
masked
image
signal
with
a
background
plate

Now, you can blend your masked image signal with a background plate using the “Overlay” layout
mode in a composite slot.

Follow these steps to create your final green screen compositing:

Create a composite or select an existing composite slot and switch to the overlay tab.
Set the masked image signal (e.g., input slot “A”) as the first source of the composite slot (=
your foreground).
Set the background plate (e.g., library slot “Lib 1”) as the second source of the composite
slot (= your background).
Expand the “Overlay” settings in the composite slot and set the opacity to 100%.

The “Overlay” settings also allow you to scale the size and offset the position of your
foreground. However, please note that those parameters will not be saved in the clip
library. If you instead apply filters to your input or library slots you can save your
adjustments to your clips.

To crop and offset the position of your background and/or your foreground, you can apply a
“Crop” filter to the library slot and/or the input slot.
To match the color of your background and/or foreground, you can apply a “Color Adjust”
filter.
To separate your foreground and background, you can soften your background plate with a
“Blur” filter.

You are currently viewing a placeholder content from Vimeo. To access the actual content, click
the button below. Please note that doing so will share data with third-party providers.

More Information

Unblock content
Accept required service and unblock content

For live monitoring and recording, you can loop your background plate. If you have set an in and
out range in your background plate, it may make sense to enable ranges playback and combine it
with looping. After the recording, the background plate remains as is and keeps looping. With the
composite slot selected you can keep previewing your composite also during playback.

Tip:Tip: Use the auto-load mechanism of library slots to quickly toggle between your background Use the auto-load mechanism of library slots to quickly toggle between your background
plates (by selecting the first clip in the bin and toggling between clips using the arrow up andplates (by selecting the first clip in the bin and toggling between clips using the arrow up and
down keys).down keys).

Tip:Tip: You can also a You can also arm and record a composite slot together with your input slots, e.g., forrm and record a composite slot together with your input slots, e.g., for
convenient recording and playback of a green screen compositing preview together with theconvenient recording and playback of a green screen compositing preview together with the
individual recordings of foreground and background.individual recordings of foreground and background.
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4.
Control
and
sync
the
sources
of
a
composite
slot

In a composite slot’s viewer controls, you can toggle between

The composite’s global controls,
the foreground’s viewer controls and
the background’s viewer controls.

You can cycle through those individual controls by clicking on the composite slot’s slot name label
or using the menu item “Cycle Viewer Controls of Composite Slot” or the associated Stream Deck
controller action.

If needed, you can sync the playhead position of your recording with the background plate by
switching to the individual controls and changing the playhead position, or the in and out range of
the clip.

For example, you can adjust the background plate’s in and out range to match the duration of the
foreground clip. Then, you can switch back to the global controls, move the (global) playhead to
the in points, and start playback (with ranges playback and looping if desired).

You are currently viewing a placeholder content from Vimeo. To access the actual content, click
the button below. Please note that doing so will share data with third-party providers.

More Information

Unblock content
Accept required service and unblock content

Audio
monitoring
and
playback
with
green
screen
compositing

When working with green screen compositing, you will usually have a composite slot selected.
Sometimes, you will also switch to an input or library slot. However, you will want to keep hearing
the audio of the input slot to listen to the live audio or the original audio that was recorded.
Consequently, disabling the automatic audio source selection and keeping the audio pinned to the
input slot is recommended.

Audio source pinned to slot “A”

On-set
editing
with
Final
Cut
Pro

Reeltime Pro integrates directly with Final Cut Pro, enabling immediate edit previews during
production. Clips—including metadata, in/out ranges, and markers—can be exported to structured
multicam or multi-track Final Cut Pro timelines for review, continuity checks, and preliminary
editing.

Projects can be opened locally in Final Cut Pro or exported as an .fcpxml file for import on other
computers. Alternatively, you can import the .fcpxml file into other NLE systems, such as DaVinci
Resolve or (via the third-party conversion tool XtoCC) into Adobe Premiere.

Tip:Tip:  An info label is displayed when hovering over an in and out range. Inspect the label to  An info label is displayed when hovering over an in and out range. Inspect the label to
see the currently set in and out points and the duration of a range.see the currently set in and out points and the duration of a range.
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In addition, Reeltime Pro supports receiving an NDI stream from Final Cut Pro. This allows routing
the edit playback back into Reeltime, where it can be monitored live or distributed to the video
village.

This article describes the full on-set editing workflow with Reeltime and Final Cut Pro.

Setting
up
NDI
and
Final
Cut
Pro
integration

In this section, you will get all instructions on how to set up on-set editing with Final Cut Pro.

Install
NDI
Tools:

If you would like to receive your editing preview from Final Cut Pro within Reeltime for monitoring
in input slots and distribution to output slots, you must ensure that you have installed the latest
version of NDI Tools for Mac. Refer to the Knowledge Base article Setting up NDI input for further
information.

Set
up
Final
Cut
Pro:

1. Open Final Cut Pro and create a library into which you can import your Reeltime exports,
e.g., a library named “Reeltime Exports”.

2. It is recommended to prevent Final Cut Pro from copying the original files into its event
media: Go to Settings > Import > Files and choose Leave files in place.

3. Go to Settings > Playback > A/V Output and choose the desired NDI output format, e.g.,
“NDI 1920 x 1080 @24”.

Set
up
Reeltime
Pro:

1. Create a dedicated input slot for receiving the A/V output from Final Cut Pro, e.g., an input
slot named “F” with the label “FCP”.

2. Associate the input slot with the NDI input stream provided by Final Cut Pro; the name of the
stream usually includes the postfix “(macOS A/V Output)”.

3. It is recommended to unarm the input slot receiving the NDI input from Final Cut Pro, as you
typically do not want to record the NDI stream together with other input sources.

4. If you have already planned to distribute the timeline’s signal to one or more dedicated
output slots, you can already set the input slot as the source for the output slot(s). However,
you can also do that later or simply route to the timeline’s signal temporarily, e.g., via the
quick routing action “Slot Follows Selection,” etc.

Exporting
clips
and
auto-generate
timelines

In this section, you will get all instructions on how to export clips from Reeltime Pro for on-set
editing with Final Cut Pro.

Exporting
clips:

You can export all clips from your current library view via the File > Export to Final Cut Pro menu
item (or the associated item in the dropdown of the export toolbar button).

Alternatively, if you only want to include specific clips, you can select the clips in the library and
export them via the File > Export Selected Clips to Final Cut Pro menu item (or the associated item
in the dropdown of the export toolbar button).

The exported clips will open in a Final Cut event bin, including the following info from Reeltime Pro:

In/out ranges (with rating) →  keyword range with name concatenated out of slate info,
ranges index and ranges rating, e.g., “SCN-26_SHO-4_TAK-7_RNG-1_★★★★★”
Best rated in/out ranges →  favorite (green line in filmstrip view)
In/out ranges notes →  keyword range
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Single-frame markers (with info) →  marker with details, e.g.,“Hair & Make-Up, check hair,
★★★”
Marker ranges (with info) → keyword range
Slate info →  Scene and Take field, e.g. Scene “26-4”, Take “7”
Comment, clip rating, flagging, caption, location → Notes field, e.g. “Comment: Check
background noise, Rating: ★★★★★, Flagged: Yes, Caption: A: Medium Close-Up Timo,
over shoulder Josie B: Medium Close-Up Josie, over shoulder Timo >> shot/reverse shot,
Location: Joiner’s workshop, Munich”

Auto-generate
timelines:

The Final Cut Pro export includes an event bin with all clips. Additionally, you can choose which
clips to include in the timeline as a starting point in the Export to Final Cut Pro window:

Included Clips: > Flagged/Best Rated Take will only include the circled takes in the timeline.
If you did not flag or rate the clips, the last take for each shot will be included.
Included In/Out Ranges: > Best Rated Range will only include the best rated in/out range of
each included take in the timeline. If you did not rate the in/out ranges, the last range of the
take will be included.

Optionally, you can also choose to apply the crop filters of Reeltime as clip transform settings in
Final Cut Pro.

Note:
Note:
If you stream your timeline’s signal back into Reeltime Pro via NDI input, keep in mindIf you stream your timeline’s signal back into Reeltime Pro via NDI input, keep in mind
that your crop filters may be reapplied if you distribute them to output slots if the crop filtersthat your crop filters may be reapplied if you distribute them to output slots if the crop filters
were configured in the output slots.were configured in the output slots.
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Final Cut Pro export window with configured options

The Final Cut Pro export will automatically generate two timelines:

The multicam timeline with the postfix “MulticamTimeline” will include multicam clips
generated from each exported group recording.

The multi-track timeline with the postfix “ClipTimeline” will include the individual clips as
overlying tracks for each exported group recording.

Direct
export
for
instant
editing
on
set

If you use Final Cut Pro on the same computer as Reeltime Pro, you can export your clips and
timelines directly to a Final Cut library. When you press the Export  button in Reeltime Pro’s Export
to Final Cut Pro window, Final Cut Pro will open automatically and display a window with the
available Final Cut Pro target libraries. You can choose the desired library or create a new one.
Then, a newly created event will open in the library, and you can open a timeline to start editing.

Tip:Tip: When using multicam editing, ensure you choose View > Show in Viewer> Angles to view When using multicam editing, ensure you choose View > Show in Viewer> Angles to view
each camera angle of the multicam clip in the Final Cut Pro viewer.each camera angle of the multicam clip in the Final Cut Pro viewer.
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XML
export
for
editing
on
other
computers
or
other
NLE
systems

Alternatively, you can export an .fcpxml file using the Export XML to Disk…  button in Reeltime Pro’s
Export to Final Cut Pro window and save the file to your desired location. Then, you can import the
.fcpxml file on another machine or into other NLE systems, such as DaVinci Resolve or (via the
third-party conversion tool XtoCC) into Adobe Premiere.

Monitoring
and
distributing
the
timeline’s
signal
in
Reeltime

If you use Final Cut Pro on the same computer as Reeltime Pro and have followed the instructions
under “Setting up on-set editing with Final Cut Pro”, you can now receive the timeline’s signal via
NDI.

You can monitor the signal in an input slot and distribute it to any configured output slot.

To receive the audio of the NDI stream, ensure you enable the channels of the “NDI Audio” input
device in Settings… > Audio > Input Devices. Typically, you don’t want to mix the timeline’s audio
signal with live audio signals, so you need to mute the other channels. Alternatively, you can output
audio directly from Final Cut Pro to the same output device as configured in Reeltime Pro (e.g., the
system audio output device) and mute live audio in Reeltime Pro when playing back a timeline.

Note:
Note:
If you import the .fcpxml file on another computer or hand the file over to anotherIf you import the .fcpxml file on another computer or hand the file over to another
department, ensure you also include a copy of the recording folder that includes the requireddepartment, ensure you also include a copy of the recording folder that includes the required
media. After the XML import, it may be necessary to relink the media in the editing system,media. After the XML import, it may be necessary to relink the media in the editing system,
e.g., in Final Cut Pro via File > Relink Files > Original Media….e.g., in Final Cut Pro via File > Relink Files > Original Media….

Tip:Tip: If you only want to temporarily distribute the timeline’s signal to one or all output slot(s), If you only want to temporarily distribute the timeline’s signal to one or all output slot(s),
consider using the quick routing actions “Slot Follows Selection” or “Slot Follows Selectionconsider using the quick routing actions “Slot Follows Selection” or “Slot Follows Selection
for All Output Slots”.for All Output Slots”.
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Multicam editing of an auto-generated timeline in FCP and feeding the timeline’s signal back to Reeltime Pro via NDI

Compatibility
with
other
NLE
systems

Although using the above-described seamless integration with Final Cut Pro is recommended, you
can also export an .fcpxml file to import it into other non-linear editing (NLE) systems. Before
exploring this option, consider the following aspects and limitations:

DaVinci
Resolve:
Supports .fcpxml import natively, but will not import any keywords, markers, or
metadata. You can still work with the auto-generated timelines, including multicam
editing.
Does not support NDI output natively. However, you can check if third-party tools,
such as FlowCaster, provide a working solution.

Adobe
Premiere:
Only supports importing Final Cut Pro 7 XMLs. However, you can use the third-party
tool XtoCC to convert and import the XML.
Supports NDI output natively.

Avid
Media
Composer:
Does not support Final Cut Pro XML import. However, you can import the .fcpxml file
into DaVinci Resolve or Adobe Premiere (as described above) and then export an AAF
file from there.
Supports NDI output natively.
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Device Integrations
Hardware
setup
options

Reeltime allows routing, capturing, and playing back SDI video signals on-set. The application
comes with built-in integrations for 

video I/O devices by AJA, Blackmagic, and DELTACAST,
video routers by AJA and Blackmagic,
Stream Deck USB controllers,
and allows audio recording and playback with any class-compliant audio interface supported
by macOS.

Please refer to the article All device integrations for an overview of all Reeltime device integrations.

You can flexibly add up to 4 input/output slots (3 inputs + 1 output or 2 inputs + 2 outputs or 1
input + 3 outputs) with Reeltime Lite

You can add up to 3 input slots and up to 6 output slots with the Reeltime Pro 3-Channel option

You can add up to 6 input slots and up to 9 output slots with the Reeltime Pro 6-Channel option

This article explains typical hardware setups with diagrams of four example setups.

Basic
hardware
setup
(1
camera
/
1
monitor)

This is a low-budget setup for a single camera shoot with one SDI monitor. You can increase the
number of cameras if you add more devices with SDI input ports, and you can increase the
number of monitors if you add more devices with SDI output ports, or a video router for splitting up
one outgoing signal to multiple destinations.

 

Tip:
Tip:
You can use multiple units of the same device type, e.g., two Blackmagic UltraStudioYou can use multiple units of the same device type, e.g., two Blackmagic UltraStudio
Recorder 3G. Furthermore, you can also use video I/O devices from different manufacturersRecorder 3G. Furthermore, you can also use video I/O devices from different manufacturers
simultaneously.simultaneously.
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Basic hardware setup with 1 camera and 1 monitor

 

Basic
hardware
setup
(2
cameras
/
2
monitors)

This is a basic setup for a two-camera shoot. In this example, there are two monitors that can
either be used as a pair for the same watcher (to show each camera signal on a separate monitor),
or they can be used by two separate watchers, e.g., one for the Director and the other for
Script/Continuity. Since the AJA Io 4K Plus has 4 bi-directional SDI ports it can handle two inputs
and two outputs simultaneously.
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Basic hardware setup with 2 cameras and 2 monitors

Advanced
hardware
setup
with
external
video
router
(2
cameras
/
2
monitors)

This is an advanced setup with external video roter for a two-camera shoot.

The video router allows for more flexible video routing options. For example, you can set up a
video routing configurations that routes the live signal directly to the monitors for lowest latency as
possible. Another video routing configuration routes the signal  through the software in order to
show playbacks, or processed live signals.

 

Tip:Tip: Automations allow you to trigger video routing configurations automatically based on Automations allow you to trigger video routing configurations automatically based on
specific events, read the article specific events, read the article Manage Configurations for an External Video RouterManage Configurations for an External Video Router..
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Advanced hardware setup with an external video router, 2 cameras and 2 monitors

Advanced
hardware
setup
with
Livegrade
(3
cameras
/
2
monitors)

This is a typical setup for shoots where the DIT in the camera department adds live color to the
unprocessed signal using Pomfort Livegrade and LUT boxes. The graded signal is then routed to
the video playback station.
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Advanced hardware setup with a Livegrade station, and 3 cameras and 2 monitors at the video playback station

 

Setting
up
AJA
video
I/O
devices

Reeltime supports the following video I/O devices by AJA for capturing and playback of SDI
signals:

AJA
Kona family (e.g., KONA 5):
up to 4 bi-directional input/output ports
1.5G, 3G, and depending on model 6G and 12G SDI signals

AJA
Io family (e.g., Io 4K Plus and Io X3)
up to 4 bi-directional input/output ports
1.5G or 3G SDI signals

AJA
Corvid family (e.g. Corvid 88)
up to 8 bi-directional input/output ports
1.5G, 3G, and depending on model 6G and 12G SDI signals

AJA
T-Tap family
T-Tap: 1 output port for playback of 1.5G or 3G SDI signals
T-Tap Pro: 1 output port for playback of 1.5G, 3G, 6G or 12G SDI signals
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Configure
bi-directional
device
ports
as
inputs
or
outputs

You can configure your device’s bi-directional SDI ports to be used as input or as output ports
within the “Devices” settings under “AJA Video I/O Configuration.”

A table displays all connected devices in a separate row, and you can choose from a range of
configuration presets supported by each device.

Device-specific AJA video I/O configuration in devices settings

When you finish configuring the device ports of your AJA video I/O devices, you need to restart the
application to apply your changes.

Associate
device
ports
with
input
and
output
slots

Within the slot manager, you can associate your AJA device’s SDI input ports with an input slot
and, in the same way, SDI output ports with output slots:

In existing slots, you can choose from all currently available ports in the “Device” drop-down
menu.
If you want to add a new slot, you can press the “+” button that lets you associate a device
port with your new slot directly.

When configuring an input port, there are the following options:

Format: The video format of the incoming video signal sets the video format of your device
automatically.
Camera
Type: Ensure that the appropriate camera type is set to receive the camera’s ANC
metadata correctly and trigger recording based on the record flag embedded in the SDI
signal.
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Record
Trigger:

You can choose which detection method should be used to trigger the
recording automatically. Note that the appropriate method depends on your setup and
camera:

Choose “Record Flag (HANC)” to detect the record flag embedded in the horizontal
ANC metadata of SDI signals from ARRI, RED, and Sony cameras.
 Choose “RecRun Timecode” if your camera is set to use RecRun timecode and you
would like to trigger recording/stop recording depending on whether the timecode is
running or the timecode is stopped.
Choose “None” to disable the auto-record function for this camera

Decoding
Levels: In rare cases, you can change the decoding levels from legal to full, for
example, if you receive an ungraded signal from a Sony camera that outputs an SDI signal in
extended range.

Slot manager with SDI device configuration for an input slot

When configuring an output port, the outgoing signals’ video formats usually derive from the input
and are, therefore, not editable. However, you can set an output video format manually if you
configure the device to use all ports as outputs.

Note:Note: AJA video I/O devices can only be set to use one video format at a time. If you need to AJA video I/O devices can only be set to use one video format at a time. If you need to
use multiple video formats, you will need one device per video format.use multiple video formats, you will need one device per video format.
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Automatic
pass-through

AJA video I/O devices with at least one input and output port support the automatic pass-through
option. This mechanism bypasses Reeltime’s video processing by routing camera signals directly
in the AJA device for zero-added latency live monitoring.

You can enable the automatic pass-through option for any compatible output port that you
configure in an output slot.

Automatic pass-through option in output slot

If automatic pass-through is enabled and the output slot shows a live signal, the mechanism
automatically switches to the unprocessed direct live feed received on an input port of the same
device.

If automatic pass-through is enabled and the output slot shows a playback signal, the feature
switches seamlessly to the output from the application.

When you change the output slot’s source to another live input, the feature automatically continues
to show a pass-through signal if the new source is from the same I/O device or seamlessly
switches to the processed output from the application.
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Pass-through
on
quit

When quitting the application, a default pass-through routing from input port(s) to output port(s) is
automatically applied. For example, if you have an AJA Io X3 configured for 2 inputs and 2 outputs
and quit the application, the signal received on input port 1 is passed through to output port 3, and
the signal received on input port 2 is passed through to output port 4.

Setting
up
Blackmagic
video
I/O
devices

Reeltime supports the following video I/O devices by Blackmagic for capturing and playback of
SDI signals:

Blackmagic
UltraStudio family (e.g., UltraStudio 4K Mini):
up to 2 input/output ports
1.5G, 3G, and depending on model 6G and 12G SDI signals

Blackmagic
DeckLink family (e.g., DeckLing 8K Pro)
up to 4 bi-directional input/output ports
1.5G, 3G, and depending on model 6G and 12G SDI signals

Associate
device
ports
with
input
and
output
slots

Within the slot manager, you can associate your Blackmagic device’s SDI input ports with an input
slot and, in the same way, SDI output ports with output slots:

In existing slots, you can choose from all currently available ports in the “Device” drop-down
menu.
If you want to add a new slot, you can press the “+” button that lets you associate a device
port with your new slot directly.

You can configure your device’s bi-directional SDI ports by assigning them as an input port or as
an output port within the slot manager’s input or output tab. If you configured a bi-directional port
as input, it will no longer show up in the drop-down list of available output ports (and vice-versa).

When configuring an input port, there are the following options:

Format: The video format of the incoming video signal sets the video format of your device
automatically.
Camera
Type: Ensure that the appropriate camera type is set to receive the camera’s ANC
metadata correctly and trigger recording based on the record flag embedded in the SDI
signal.
Record
Trigger:

You can choose which detection method should be used to trigger the
recording automatically. Note that the appropriate method depends on your setup and
camera:

Do not choose “Record Flag (HANC),” as Blackmagic devices do not support receiving
the record flag embedded in the horizontal ANC metadata for SDI signals.
 Choose “RecRun Timecode” if your camera is set to use RecRun timecode and you
would like to trigger recording/stop recording depending on whether the timecode is
running or the timecode is stopped.
Choose “None” to disable the auto-record function for this camera

Important
Note:Important
Note: For configuring two or more simultaneous pass-throughs using a single I/O For configuring two or more simultaneous pass-throughs using a single I/O
device, it is important to genlock the camera signals. For example, if you want to showdevice, it is important to genlock the camera signals. For example, if you want to show
camera A on the director’s monitor and camera B on the script supervisor’s monitor, and bothcamera A on the director’s monitor and camera B on the script supervisor’s monitor, and both
should see a pass-through signal for zero-added latency, ensure to genlock camera A and Bshould see a pass-through signal for zero-added latency, ensure to genlock camera A and B
(e.g., using an Ambient Lockit or similar device.)(e.g., using an Ambient Lockit or similar device.)
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Decoding
Levels: In rare cases, you can change the decoding levels from legal to full, for
example, if you receive an ungraded signal from a Sony camera that outputs an SDI signal in
extended range.

Slot manager with SDI device configuration for an input slot

When configuring an output port, you can set an output video format manually. However, it is
recommended that the output’s video format be set based on the incoming video format.

Setting
up
DELTACAST
video
I/O
cards

Reeltime supports a wide range of video I/O cards by DELTACAST for capturing and playback of
SDI signals.

Note:Note: If you experience issues with re-connecting Blackmagic video I/O devices, please refer If you experience issues with re-connecting Blackmagic video I/O devices, please refer
to the article to the article Troubleshoot re-connecting of Blackmagic video I/O devicesTroubleshoot re-connecting of Blackmagic video I/O devices..

Note:Note: Ensure that your installed DELTACAST VideoMaster driver version matches the SDK Ensure that your installed DELTACAST VideoMaster driver version matches the SDK
version used in your Reeltime version. You can see the SDK version in the “Reeltimeversion used in your Reeltime version. You can see the SDK version in the “Reeltime
Pro”/”Reeltime Lite” menu under “About Reeltime Pro”/”About Reeltime Lite” > “SDKPro”/”Reeltime Lite” menu under “About Reeltime Pro”/”About Reeltime Lite” > “SDK
Versions”.Versions”.
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Associate
device
ports
with
input
and
output
slots

Within the slot manager, you can associate your Blackmagic device’s SDI input ports with an input
slot and, in the same way, SDI output ports with output slots:

In existing slots, you can choose from all currently available ports in the “Device” drop-down
menu.
If you want to add a new slot, you can press the “+” button that lets you associate a device
port with your new slot directly.

You can configure your device’s bi-directional SDI ports by assigning them as an input port or as
an output port within the slot manager’s input or output tab. If you configured a bi-directional port
as input, it will no longer show up in the drop-down list of available output ports (and vice-versa).

When configuring an input port, there are the following options:

Format: The video format of the incoming video signal sets the video format of your device
automatically.
Camera
Type: Ensure that the appropriate camera type is set to receive the camera’s ANC
metadata correctly and trigger recording based on the record flag embedded in the SDI
signal.
Record
Trigger:

You can choose which detection method should be used to trigger the
recording automatically. Note that the appropriate method depends on your setup and
camera:

Choose “Record Flag (HANC)” to detect the record flag embedded in the horizontal
ANC metadata of SDI signals from ARRI, RED, and Sony cameras.
 Choose “RecRun Timecode” if your camera is set to use RecRun timecode and you
would like to trigger recording/stop recording depending on whether the timecode is
running or the timecode is stopped.
Choose “None” to disable the auto-record function for this camera

Decoding
Levels: In rare cases, you can change the decoding levels from legal to full, for
example, if you receive an ungraded signal from a Sony camera that outputs an SDI signal in
extended range.

Tip:Tip: See DELTACAST’s cabling guide for your SDI card to identify the device ports. See DELTACAST’s cabling guide for your SDI card to identify the device ports.
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Slot manager with SDI device configuration for an input slot

When configuring an output port, you can set an output video format manually. However, it is
recommended that the output’s video format be set based on the incoming video format.

Setting
up
full
screen
output
devices

Reeltime supports using HDMI/DisplayPort/USB-C/Thunderbolt monitoring devices as “full screen
output devices”, enabling high-quality video signal distribution directly from your Mac’s built-in
HDMI or Thunderbolt output ports. The feature enables flexible, low-latency monitoring on
computer monitors, TVs, or via converters for SDI-based setups.

macOS
display
configuration

Before enabling full screen outputs in Reeltime:

1. Connect your target monitor or device to your Mac using an HDMI or
Thunderbolt/DisplayPort cable.

2. Open System Settings > Displays and:

Set the desired resolution for the connected display.

Adjust the refresh rate to 60 Hz or 50 Hz for optimal low-latency performance. Lower
refresh rates are supported, but will result in increased delay.

Disable True Tone to avoid unwanted color shifts on video outputs.
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Reeltime
configuration

1. Go to Reeltime > Settings > Devices.

2. Enable the desired HDMI/DisplayPort/USB-C/Thunderbolt-connected display as full screen
output device.

3. Select a layout:

Single view: one “FSO” (full screen output) will be available in the slot manager.

Quad view: four individual “FSO” outputs will be available in the slot manager.

4. In the slot manager:

Assign one or more of the “FSO” outputs to your output slots.

Set the desired source for each slot.

In the devices settings, there is also an option to automatically reset the mouse cursor to the main
display window if it is moved into a full screen output.

The “Auto-reset cursor to main window” option is enabled by default.

If the cursor remains inactive in the full screen output area, it is automatically
repositioned to the main interface after a short delay.

Configured full screen output devices in the devices settings

Quad
view
for
converter
integrations

Full screen outputs configured as quad view support splitting a 4K signal into 4 HD-SDI signals
using HDMI or DisplayPort to SDI converters.

Important
NoteImportant
Note: Avoid changing a display’s resolution while it is being used as a full screen: Avoid changing a display’s resolution while it is being used as a full screen
output device. If you adjust macOS display settings, restart Reeltime to ensure stable outputoutput device. If you adjust macOS display settings, restart Reeltime to ensure stable output
behavior.behavior.
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Supported
converters

Full screen outputs configured as quad view allow outputting a single 4K HDMI/DisplayPort signal
that can be split into four independent HD-SDI outputs using supported converters:

AJA
HA5-4K: Converts a 4K HDMI signal into four 3G-SDI outputs.

 

Setting
up
Stream
Deck
controllers

Reeltime integrates with Elgato’s Stream Deck devices. There are pre-configured profiles for

Stream Deck Classic
Stream Deck XL

devices.

Stream Deck configuration app with installed Reeltime Pro profile

Important
NoteImportant
Note: The AJA HA5-4K requires an HDMI 2.1 compatible HDMI port, which are: The AJA HA5-4K requires an HDMI 2.1 compatible HDMI port, which are
usually available on Macs with an M2 chip (or newer).usually available on Macs with an M2 chip (or newer).
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Installation
of
your
Stream
Deck
device(s)

To get started with your Stream Deck device(s),

download and install the latest Stream Deck configurations app from Elgato’s website,
attach all Stream Deck device(s) you want to use with your computer and
open Reeltime and choose the menu item “Reeltime Pro”/”Reeltime Lite” > “Install
Stream
Deck
Plugin…”

Reeltime will then install

Actions for Stream Deck devices
Default
profiles with recommended configurations for all currently attached Stream Deck
devices

Add
another
Stream
Deck
device

If you already installed a Stream Deck device on your computer and want to use another one,
attach it via USB to your machine and click “Reeltime Pro”/”Reeltime Lite” > “Install
Stream
Deck
Plugin…”
to add default profiles for your attached Stream Deck device.

Configure
and
manage
profiles

After installing the Stream Deck plugin, open the configuration app and configure the profiles to
your personal needs. You can assign, move, or delete actions to the buttons of your Stream Deck.

Troubleshooting

“My
Stream
Deck
buttons
show
?
question
marks.”

A
re-install
of
the
Stream
Deck
plugin
most
often
helps.

Make sure that you are on the latest Reeltime version
Close Reeltime
Uninstall the Reeltime plugin in the Stream Deck configurations app by right-clicking on one
of the Reeltime actions and choosing “Uninstall…”
Open Reeltime and go to “Reeltime Pro”/”Reeltime Lite” > “Install
Stream
Deck
Plugin…”

“I
updated
to
a
new
Reeltimeversion,
and
some
Stream
Deck
Actions
don’t
work
anymore”

Re-install
the
Stream
Deck
plugin
via
your
updated
Reeltime
application.

Close Reeltime
Open Stream Deck configurations app and backup your Stream Deck profiles if you have
customized profiles
Uninstall the Reeltime plugin in the Stream Deck configurations app by right-clicking on one
of the Reeltime actions and choosing “Uninstall…”
Open Reeltime and go to “Reeltime Pro”/”Reeltime Lite” > “Install
Stream
Deck
Plugin…”
Check if your profiles work again, and if necessary, replace non-working actions with a new
action

 

Manage
configurations
for
an
external
video
router
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Video routers often sit at the core of a flexible video playback station. Video routers have multiple
input and output ports and allow to easily switch the connections between these ports. Reeltime
comes with the ability to control a video router and to apply pre-defined configurations of
connections – either manually or on certain events such as switching slots in the application’s user
interface.

The various hardware setup options with Reeltime are described in the article Hardware Setup
Options.

Hardware setup with an external video router, 2 cameras, and 2 monitors

Reeltime has an additional, dedicated view for directly controlling a video router and monitoring
routings visually. See Interactive Router Control for detailed information.

You need a working network connection between the computer running Reeltime and the video
router. For setting up the network, please refer to your video router’s manual.

Managing
video
routing
configurations

You open the Video Routing Configurations window from the main menu by choosing “Configure
Video Routing” > “Manage Configurations…”  from the application menu.
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Video Routing Configurations window

The Video Routing Configurations window shows a list of configured configurations and options to
edit, duplicate, and delete a selected configuration. You can also test the selected configuration by
clicking the “Apply Configuration…” button.

You can rename a configuration by double-clicking the entry in the list.

The configurations have an automatically assigned index number for easier referencing (e.g. when
using Stream Deck devices to apply configurations remotely).

You can change the order of the configurations by dragging and dropping a configuration entry in
the “Manage Configurations” window.

Creating
a
new
video
routing
configuration

By clicking the “New Configuration…” or choosing  “Configure Video Routing” > “New
Configuration…”  from the application menu, you open the dialog for creating a new video routing
configuration.

To create connections between the in and out ports of your router, you need to connect to the
router first. This is needed so the application can fetch a list of ports and their names from the
router.
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Choose an auto-detected router in the “Router” popup button, or choose the router model family
you have (AJA Kumo or Blackmagic Design Smart VideoHub) and enter your router’s IP address or
hostname. Click the “Fetch IN/OUT Information” button. If the router’s information has been
fetched successfully, the controls below the connection table get enabled, and you can start
creating new connections.

Editing a video routing configuration

Click the “+” button to create a new connection and “-“ to remove the selected connection.

When clicking the “+” button below the connection table, you can choose which input (IN) port
should be connected to which output (OUT) port. Choose the ports according to your setup and
click “Add”. You can edit the connection at any time by double-clicking the connection.

Only connections of shown OUTs will be changed when the routing configuration is applied. All
other output ports of your router will remain unchanged when applying this configuration.

You can test your current configuration by clicking the “Apply Configuration” button. The
configuration will become active in the connected video router.

You can sort the connection table by IN our OUT ports and choose if the selected column is sorted
by name or port number with the “Sort Criteria” controls below the table.
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When clicking “Load All Connections…” you can fill the connection table with your video router’s
current, complete routing configuration. This can be useful as a starting point for complex routing
configurations with lots of connections.

When clicking “Save…”, you will be prompted with a name for the video routing configuration, and
the configuration appears in the list of configurations in the Video Routing Configurations window.

Applying
video
routing
configurations
via
the
menu
and
keyboard
shortcuts

Once a video routing configuration is saved, it will also appear in the “Video Routings” submenu of
the application menu. When choosing one of the stored configurations in the menu, the
configuration gets applied to the connected router.

You can assign keyboard shortcuts to the menu entries for individual video routing configurations
with the Keyboard Shortcuts Manager. This allows you to switch between video routing
configurations with keyboard shortcuts easily.

See the article about the Working With Keyboard Shortcuts for more information.

Applying
video
routing
configurations
from
Stream
Deck

You can also apply up to 20 video routing configurations from Stream Deck devices using the
Stream Deck plugin. There is a dedicated “Routing” page in the default profiles.

Automating
video
routing
configurations

You can automate video routing configurations by using them as actions in the Automation
Manager. This allows you to automate the change of the routing configuration based on a specific
event. For example, you can apply different configurations based on whether an output slot
receives a live or playback signal to ensure the Director always receives a live signal as a direct
feed from the camera without latency.

Automation Manager with configured automations to trigger video routing configurations

Interactive
video
router
control

In addition to defining routing presets (see Manage configurations for an external video router for
more information) Reeltime has a dedicated view for directly controlling a video router and monitor
routings visually. 

The video router view displays all inputs and outputs of a connected video router, and lets you
interactively change routings.
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You can open the video router panel with a dedicated button in the toolbar, or via the application
menu “Video Router…”.

Interactive video routing panel

 

Connecting
to
a
video
router

Choose an auto-detected router in the “Router” popup button, or choose the router model family
you have (AJA Kumo or Blackmagic Design Smart VideoHub), enter the IP address or hostname of
your router and click the connection button besides the field for the IP address. You can
disconnect the video router anytime by clicking the connection button again.

Managing
connections


The Video Router view displays all connections between input ports and output ports currently
active in the connected video router.

Usually, an input port can be connected to multiple output ports, but an output port can only be
connected to one input port. Connections between ports are displayed as colored lines.

Input ports are displayed on the top of the view (on the left in vertical layout), output ports are
displayed on the bottom of the view (on the right in vertical layout). The ports display the port
number in the router (the circled number) and one or two rows of the name of the port.

Port names can be configured in your video router’s administration interface. Please refer to your
router manual to learn how to do that.

When connections change (either from within the application or from outside, e.g., by using a
hardware control panel or the web UI), they flash in white to indicate the change.
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Changing
connections
via
selecting
ports

You can select a port by clicking on it. The port and it’s current connections get highlighted. You
then can click on one of the ports of the other port type to change a connection:

For example, when an input port is selected first and an output port is selected second, the output
port changes its connection to the selected input port. You can achieve the same effect by
selecting an output port first and the input port second.

Changing video routing connections by clicking on ports

You can select ports also from the utility menu in the wedge button in the header bar of the Video
Routing view, or from the main menu by choosing one of the entries in the “Interactive Video
Routing” submenu of the “Video Routing” menu in the application menu.

You can also right-click on each port button to inspect and change the connected port(s).

Changing
connections
via
drag-and-drop

Each port has a small colored circle besides it. You can drag a line from this circle to the port that
you want to make connection with.

Video
routing
configurations

You can set up video routing configurations as shortcuts to change one or more connections. See
Manage configurations for an external video router for more information.

Configured video routing configurations appear as menu items in the wedge button in the header
bar of the Video Routing panel.

You can also use the current state of the video router with all its connections as a starting point for
a new configuration. Choose “Save Current Connections…” in the menu of the wedge button in the
header bar of the Video Routing view.

Configuring
the
video
routing
interaction

You can view connections either in horizontal layout or vertical layout. Choose “View in Vertical
Layout” or “View in Horizontal Layout” menu items in the wedge button in the header bar of the
Video Routing view to change the layout.

Setting
up
audio
I/O
interfaces

This article walks you through setting up audio I/O interfaces in Reeltime:
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Connect your audio interface(s) to your machine
You can connect any audio source that is supported by macOS, including embedded
audio channels from SDI signals via the drivers by AJA and Blackmagic

Open Reeltime’s audio settings
The audio settings allow selecting multiple audio input devices and mixing their
channels into one dual-mono audio output signal for recording and monitoring

Audio settings with multiple audio inputs

The “Input Devices” list displays all audio devices connected to your machine.
You can enable all channels you want to use. Each channel has an individual volume
slider.
The “Input Delay” setting allows you to add an audio delay to the audio recording to
keep it in sync with the video signals

For audio monitoring and playback, you can choose an output device or select to use the
system’s audio output device

including embedded audio output for SDI signals via the drivers by AJA and
Blackmagic

The audio meters in the toolbar visualize the active audio in green (for playback), blue (for
monitoring), and grey (if the audio is muted)

Note:Note: If a device is not configured to 48 kHz, it is displayed in red and cannot be used. If a device is not configured to 48 kHz, it is displayed in red and cannot be used.
However, you can open the Audio MIDI Setup to configure the device to 48 kHz.However, you can open the Audio MIDI Setup to configure the device to 48 kHz.
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There are menu items (in the audio menu) and associated Stream Deck controller actions for
muting the live audio or all audio, as well as an associated global mute toolbar button.
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Streaming Integrations
Distributing
local
streams
for
companion
apps

Reeltime Pro lets you distribute local streams for the companion apps Reeltime Cinema and
Reeltime Viewer. The video streams you distribute from Reeltime Pro in the local network are
protected using industry-standard encryption to fulfill your production’s security guidelines.

Like all other outgoing signals, you can configure local streams in the output slots. The current
version of Reeltime Pro supports up to 9 output slots. Consequently, you can distribute up to 9
different local streams (if you do not need further outgoing signals such as SDI outputs to
monitors). 

To give your crew access to the local streams, you can set a password in Reeltime Pro’s local
streaming settings and share the password with your team members. Additionally, you can display
a QR code that links to the companion apps in the App Store or copy the link to share it with other
team members.

Local streaming settings

To add another output slot as a local stream, open the slot manager and add an output slot in the
“Output” tab. Choose “Local Stream” under “Device” and name the output slot as intended.

You can modify the target bitrate in the output slot settings and inspect how many clients are
connected to the stream (output slot). Furthermore, a diagram visualizes the round-trip time
statistics for each connected client so that you can monitor the connection quality if needed.

Tip:
Tip:
Reeltime Pro’s filter and compositing options let you optimize the appearance of yourReeltime Pro’s filter and compositing options let you optimize the appearance of your
streams according to the production’s guidelines and the individual use cases of the watchingstreams according to the production’s guidelines and the individual use cases of the watching
roles. For example, you could add an image overlay filter to all streams if your production’sroles. For example, you could add an image overlay filter to all streams if your production’s
security guidelines require that. Or you can create one stream with a clean image for thesecurity guidelines require that. Or you can create one stream with a clean image for the
Director and another with metadata overlays for Script / Continuity.Director and another with metadata overlays for Script / Continuity.

Note:Note: The output slot’s name will appear as the stream’s name within the companion app. So, The output slot’s name will appear as the stream’s name within the companion app. So,
remember that the name should be meaningful and self-explanatory for everyone with accessremember that the name should be meaningful and self-explanatory for everyone with access
to the local streams.to the local streams.
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Setting up local streaming through an output slot in the slot manager

 

Distributing
internet
streams
via
internet
streaming
services

Reeltime Pro comes with integrations for a wide range of internet streaming services:

Sony
Ci
Media
Cloud
RePro
Stream
Autodesk
Flow
Capture

and the hardware-based integrations with

Teradek
TV and
Sohonet
ClearView
Flex

You can set up and control an internet stream through an output slot. If your service supports
multiple streams and the network quality and speed are sufficient, you can also set up various
streams that work simultaneously.

For the software-based internet streaming integrations with Sony Ci Media Cloud, RePro Stream,
and Autodesk Flow Capture  you first need to create a live stream on the service’s platform. Please
refer to your service’s documentation for more information.
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All internet streams are secured using industry-standard encryption.

Read more about the detailed setup process in the following articles:

Setting up an internet stream with Sony Ci Media Cloud
Setting up an internet stream with RePro Stream
Setting up an internet stream with Autodesk Flow Capture

For the hardware-based integrations with Teradek TV and Sohonet ClearView Flex, you set up the
streams via an SDI output port of a video I/O device connected to your machine. Then, you
connect the SDI output port to an SDI input port of a compatible hardware device by the
manufacturer. Please refer to your service’s documentation for more information.

Read more about the detailed setup process in the following articles:

Setting up a hardware-based internet stream with Teradek TV
Setting up a hardware-based internet stream with Sohonet ClearView Flex

Setting
up
an
internet
stream
with
Sony
Ci
media
cloud

To set up an internet stream via Sony Ci Media Cloud, you first need to create a live stream on the
service’s platform. For more information, please refer to Sony Ci Media Cloud’s documentation.

Once your live stream is created, you can configure the internet stream in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Select “Internet Stream” under “Device” and name the output slot as desired,
Choose “Sony Ci Media Cloud” and fill in the live stream information you can copy from the
platform’s interface.
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Output slot with Sony Ci Media Cloud internet streaming configuration

You can configure the stream’s resolution, framerate, and target bitrate to optimize them according
to your production’s requirements and the technical conditions on set.

Setting
up
an
internet
stream
with
RePro
stream

To set up an internet stream via RePro Stream, you first need to create a live stream on the
service’s platform. For more information, please refer to RePro Stream’s documentation.

Once your live stream is created, you can configure the internet stream in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Select “Internet Stream” under “Device” and name the output slot as desired,
Choose “RePro Stream” and fill in the live stream information you can copy from the
platform’s interface.

Note:Note: The video stream includes the application’s main audio, which is currently audible. The video stream includes the application’s main audio, which is currently audible.
Hence, you may need to unmute the live audio to send a stream with audio.Hence, you may need to unmute the live audio to send a stream with audio.
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Output slot with RePro Stream internet streaming configuration

You can configure the stream’s resolution, framerate, and target bitrate to optimize them according
to your production’s requirements and the technical conditions on set.

Setting
up
an
internet
stream
with
Autodesk
Flow
Capture

To set up an internet stream via Autodesk Flow Capture, you first need to create a live stream on
the service’s platform. For more information, please refer to Autodesk Flow Capture’s
documentation.

Once your live stream is created, you can configure the internet stream in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Select “Internet Stream” under “Device” and name the output slot as desired,
Choose “Autodesk Flow Capture” and fill in the live stream information you can copy from
the platform’s interface.

Note:Note: The video stream includes the application’s main audio, which is currently audible. The video stream includes the application’s main audio, which is currently audible.
Hence, you may need to unmute the live audio to send a stream with audio.Hence, you may need to unmute the live audio to send a stream with audio.
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Output slot with Autodesk Flow Capture internet streaming configuration

You can configure the stream’s resolution, framerate, and target bitrate to optimize them according
to your production’s requirements and the technical conditions on set.

Setting
up
a
hardware-based
internet
stream
with
Teradek
TV

To set up an internet stream with Teradek TV, you configure the stream via an SDI output port of a
video I/O device connected to your machine. Then, you connect the SDI output port to an SDI
input port of a compatible hardware device by the manufacturer. Please refer to Teradek TV’s
documentation for more information.

Once your hardware is connected appropriately, you can configure the internet stream via Teradek
TV in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Choose “Internet Stream” under “Device”,
Choose “Teradek TV” and configure the stream via an SDI output device.

Note:Note: The video stream includes the application’s main audio, which is currently audible. The video stream includes the application’s main audio, which is currently audible.
Hence, you may need to unmute the live audio to send a stream with audio.Hence, you may need to unmute the live audio to send a stream with audio.
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Output slot with Teradek TV configuration

Setting
up
a
hardware-based
internet
stream
with
Sohonet
ClearView
Flex

To set up an internet stream with Sohonet ClearView Flex, you configure the stream via an SDI
output port of a video I/O device connected to your machine. Then, you connect the SDI output
port to an SDI input port of a compatible hardware device by the manufacturer. Please refer to
Sohonat ClearView Flex’s documentation for more information.

Once your hardware is connected appropriately, you can configure the internet stream via Sohonet
ClearView Flex in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Choose “Internet Stream” under “Device”,
Choose “Sohonet ClearView Flex” and configure the stream via an SDI output device.

Note:Note: For some video I/O devices, you cannot choose a video format for the output ports if For some video I/O devices, you cannot choose a video format for the output ports if
the device’s input ports are already configured to a specific video format.the device’s input ports are already configured to a specific video format.
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Output slot with Sohonet ClearView Flex configuration

Setting
up
a
generic
internet
stream

To set up a generic internet stream, you first need to create an SRT or RTMP stream using your
own server or your preferred streaming service provider.

Once your live stream is created, you can configure the internet stream in the output slots:

Open the slot manager and add an output slot in the “Output” tab,
Select “Internet Stream” under “Device” and name the output slot as desired,
Choose “Generic” and fill in the live stream information.

Note:Note: For some video I/O devices, you cannot choose a video format for the output ports if For some video I/O devices, you cannot choose a video format for the output ports if
the device’s input ports are already configured to a specific video format.the device’s input ports are already configured to a specific video format.
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Output slot with generic internet streaming configuration

You can configure the stream’s resolution, framerate, and target bitrate to optimize them according
to your production’s requirements and the technical conditions on set.

Note:Note: The video stream includes the application’s main audio, which is currently audible. The video stream includes the application’s main audio, which is currently audible.
Hence, you may need to unmute the live audio to send a stream with audio.Hence, you may need to unmute the live audio to send a stream with audio.
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Setting
up
NDI
input

Reeltime Pro supports receiving available NDI input streams in your network via input slots, e.g.,
for monitoring your Final Cut Pro timeline’s A/V output and distributing the editing preview to the
video village.

Install
NDI
Tools
for
Mac
and
create
a
stream

Install the latest version of NDI Tools for Mac
Create an NDI stream with a third-party application such as Final Cut Pro

In Final Cut Pro: Go to Settings > Playback > A/V Output and choose the desired NDI
output format, e.g., “NDI 1920 x 1080 @24”.

If NDI output does not appear in Final Cut Pro’s “A/V Output” settings, you may need to
restore legacy video device support within the macOS Recovery Mode:

Shut down your Mac
Press and hold the power button until the options appear, then

continue with “Options” and log in
Open Terminal from the utilities menu
Enter the command: system-override legacy-camera-plugins-without-
sw-camera-indication=on
If the returned message is “command not found”, you first have to

disable System Integrity Protection (SIP). That is also only possible within the
macOS Recovery Mode:
If necessary, restart your Mac and enter Recovery Mode as described above
Open Terminal from the utilities menu
Enter the command: csrutil disable
Repeat the steps above to restore legacy device support
Remember to re-enable SIP after you have completed the necessary changes:
csrutil enable

 

Associate
an
NDI
stream
with
an
input
slot

1. Create a dedicated input slot for receiving the NDI stream, e.g., the A/V output from Final Cut
Pro.

2. Associate the input slot with the NDI input stream; for example, Final Cut Pro’s A/V output
stream typically includes the postfix “(macOS A/V Output)”.

3. To receive audio embedded in the NDI stream, enable the channels of the “NDI Audio” input
device in Settings> Audio > Input Devices.
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User Interface
Multiple
window
layouts

Reeltime has multiple window layouts, each providing different UI elements optimized for typical
activities and common setups.

The “Main
View”
window
layout allows access to all components in the application, such
as

the slot column with sections for input slots, library slots, composite slots, and output
slots,
the “Main Viewer” with recording and playback controls for the currently selected slot,
the global metadata,
and the clip library

The View > Enter Main Viewer Full Screen menu item, or the associated keyboard shortcut,
or Stream Deck controller action opens the main viewer’s signal in full screen (without UI
elements). You can exit the full screen view with the Esc  key, or using the same keyboard
shortcut or Stream Deck controller action.

Main View window layout

The “Multi
View”
window
layouts are designed to allow viewing and controlling multiple
slots simultaneously and provide viewers with controls for all active slots based on the slot
types:

Input slots (multi view)
Library slots (multi view)
Output slots (multi view)

Tip:Tip: The multi view layouts are optimized to view all your camera feeds simultaneously, also if The multi view layouts are optimized to view all your camera feeds simultaneously, also if
you work on a small screen, and you do not have a dedicated SDI monitor at your workstationyou work on a small screen, and you do not have a dedicated SDI monitor at your workstation
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Multi view layouts automatically adapt their sizing and grid layout depending on the number of
configured slots. The multi view layouts can display up to 3×3 (9 slots).

The global metadata panel in the multi view layouts works similarly to the global metadata panel in
the main view layout but uses a horizontal layout with larger text boxes. You can increase the
values in a text box with the arrow up/down keys and navigate back and forth between fields with
a tab or shift tab.

Multi View window layout with two input slots

A picker in the toolbar and associated Stream Deck controller actions let you quickly switch
between window layouts.

Stream Deck actions allow switching between window layouts

 

Viewer
controls

Reeltime’s viewer controls are essential for controlling recording and playback in slots. Hence, the
viewer controls are one of the core UI elements positioned in a separate bar below the image within
the main view’s viewer window and all multi views’ viewer windows.

The viewer controls display different elements depending on

the slot’s
type (input/library/composite/output slots)
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the slot
mode (live/playback/reference)
live slot mode: the viewer controls are recording
controls that allow controlling a
slot’s recording actions
playback and reference slot modes: the viewer controls are playback
controls that
allow controlling a slot’s playback actions

the window
layout (main view/multi view)

In summary, there are two types of viewer controls – recording and playback, depending on the
slot’s mode. Furthermore, the options provided within the controls vary also depending on the slot
type.

Recording
controls

Recording controls provide controls for triggering recording actions in a single slot or timecode-
synced groups of slots. Furthermore, recording controls allow setting multiple in and out ranges
while recording. Recording controls contain the following elements:

Slot
character label
displays the slot’s slot character

Note: the slot character is only available in input slots
Slot
label label

displays the slot’s slot label
Note: in slots without slot character (= library/composite/output slots), the slot
label is displayed at the position and size of the slot character (first position in
larger font size)

Slot
mode indicator
indicates the currently set slot mode (live/playback/reference)

Sync
info label
for group recordings only: displays a sync icon and the slot characters of all slots that
are synced in the current group recording

Arming button
allows arming/un-arming the slot for the upcoming (group) recording

Record button
starts/stops recording
the button is red during recording

Set
Marker button
sets a marker at the current position

can also be a group marker button (adjustable in the library settings)
Set
in button

sets an in-point or moves an existing in-point to the current position
Set
out button

sets an out-point or moves an existing out-point to the current position
Timecode label

displays the incoming SDI timecode of the connected device or the current time as
timecode (depends on recording settings)

Scrub
bar
Elapsed
time label

displays the elapsed time of the current recording
In/out
ranges

display the marked in/out ranges in the current recording within the scrub bar

Note:Note: Slot modes only exist in input slots but also influence composite and output slots with Slot modes only exist in input slots but also influence composite and output slots with
an input slot as source configured.an input slot as source configured.
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Recording controls

Playback
controls

Playback controls provide flexible options for playing back single recordings or timecode-synced
group recordings. Furthermore, playback controls allow navigating within the recording/s and
editing or adding in/out ranges. The playback controls contain the following elements:

Slot
character label
only available in input slots

Slot
label label
Slot
mode indicator

indicates the currently set slot mode (live/playback/reference)
Slate/clip
info label

By clicking on the label, the label displays
the slate info of the loaded clip (“Standard” slating system: scene/shot/take,
“American” slating system: scene/take),
or the clip name of the loaded clip

Sync
info label
for group recordings only: displays a sync icon and the slot characters of all slots that
are synced in the current group recording that is loaded for playback

Previous
frame button
moves the playhead position to the previous frame

Play button
toggles between play/pause
the button is blue during playback

Jump
to
previous
marker button
moves the playhead position to the previous marker

Jump
to
next
marker button
moves the playhead position to the next marker

Set
marker button
sets a marker at the current position

can also be a group marker button (adjustable in the library settings)
Jump
to
previous
in button

cycles backward through the existing in-points in the clip
Jump
to
next
in button

cycles forward through the existing in-points in the clip
Set/Move
in button

sets an in-point at the current position or moves an existing in-point to the current
position

Set/Move
out button
sets an out-point at the current position or moves an existing out-point to the current
position

Playback
speed badge
displays the current playback speed

Timecode label
displays the timecode of the loaded clip at the current playhead position (frame)

Ranges
playback
mode button
toggles between the modes “Ignore Rangers”, “Current Range”, and “All Ranges”

Loop
playback button
enables/disables loop playback (can be “combined” with the above ranges playback
options)
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Scrub
bar
Elapsed
time label

displays the elapsed time of the loaded clip’s duration at the current playhead
position

Playhead
displays the current playhead position within the scrub bar

In/out
ranges
the current range / all ranges can be highlighted or dimmed depending on the
ranges playback mode (ignore ranges/current range/all ranges)

Markers
the selected marker is displayed as a filled marker symbol; other markers are
displayed with an outlined marker symbol

Remaining
time label
displays the remaining time of the loaded clip’s duration from the current
playhead position

Playback controls

 

Output
slots
viewer
controls

Output slots display the viewer controls of their source slots (input slots/library slots/composite
slots)

Recording controls or playback controls, depending on the slot mode of the configured
source input slot
Additionally, there are

Buttons for
Set
“Slot
Follows
Selection”
for
all
output
slots

sets “Slot Follows Selection” for all currently configured output slots so
that the input source for all output slots temporarily follows the slot
selection in the UI

Set
“Force
Slot
to
Live
Video”
for
all
output
slots
sets “Force Slot to Live Video” for all currently configured output slots so
that all output slots receive only the live signal of their configured input
source slot

An indicator with a reveal button for the configured
input
source
displays the currently configured source slot and allows to go to the associated
slot when pressing the “reveal” button

In/Out
ranges
and
markers
tab

Reeltime’s in/out ranges and markers tab lives within the upper right side of the main view
(between the slot settings and the global metadata tabs). 

The tab shows all in/out ranges and markers of the currently running recording (live mode), or the
currently loaded clip (playback mode). If the current recording/clip belongs to a group, all in/out
ranges also apply to all associated group recordings/group clips. The same applies to group
markers and the group thumbnail frame. 

The in/out ranges and markers tab has three sub-tabs, “In/Out”, “Markers” and “All”. The “All” tab
displays all elements of both the “In/Out” and “Markers” tab in one view. The “In/Out” and
“Markers” tabs are explained in more detail below.
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In/Out
ranges
tab

The In/Out
tab displays all in/out ranges of the selected slot’s recording or loaded clips:

In/out ranges toolbar

In/Out
ranges
toolbar:
A toolbar at the top of the list provides buttons for the most
important in/out ranges-related actions:

Set
in
sets an in-point at the current position of the recording (live mode),
or at the current playhead position (playback mode)

Set
out
sets an out-point at the current position of the recording (live mode),
or at the current playhead position (playback mode)

Set
new
range
with
in
at
playhead
position
adds a new range with an in-point at the current playhead position (playback
mode only)

Set
new
range
with
out
at
playhead
position
adds a new range with an out-point at the current playhead position (playback
mode only)

Jump
to
previous
in
moves the playhead to the previous in-point (playback mode only)

Jump
to
next
in
moves the playhead to the next in-point (playback mode only)

In/out ranges list
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In/Out
ranges
list: Below the toolbar, there is a list view where you can inspect all in/out
ranges of the clip and edit their information or navigate to their in-points or out-points:

Rating

allows setting a rating (no rating – 5 stars) by clicking on the stars or using the
associated menu items, keyboard shortcut, or Stream Deck controller actions

Note
field
allows adding a text note:

click into the field or use the tab key to enter it,
after typing your desired note text, you can exit the field with the keyboard
shortcut Cmd-Enter

In/Out
and
duration
lets you inspect the in-point’s and out-point’s timecodes and the duration of the
range
and jump to the in-point or out-point by clicking on the reveal buttons after the
timecode labels

Contextual
menu:
The in/out ranges list provides various contextual menu items via a right-
click on an in/out range (multi-selection is possible for some items only):

Jump to In
Jump to Out
Set Rating
Remove
Copy Ranges to Text

Markers
tab

The Markers
tab displays all markers of the selected slot’s recording or loaded clips:

Markers tab
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Markers
toolbar:
A toolbar at the top of the list provides buttons for the most important
marker-related actions:

Set
default
marker
type
defines the marker type for the next marker
select from eight colored marker types that you can customize in a “Marker
Names” box within the library settings

Set
marker
sets a marker at the current position of the recording (live mode),
or at the current playhead position (playback mode)

Set
marker
for
group
sets a marker for all recordings of the group at the current position of the
recording (live mode),
or for all clips of the group at the current playhead position (playback mode)

Set
marker
out
for
selected
marker
sets a marker out point for a selected marker at the current position of the
recording (live mode) / at the current playhead position (playback mode)

Move
selected
marker
in
to
playhead
position
moves a selected marker to the current position of the recording (live mode) / to
the current playhead position (playback mode)

if the marker is a range only the in point of the maker is moved
Set
thumbnail
frame

sets the thumbnail frame at the current position of the recording (live mode),
or at the current playhead position (playback mode)

Set
thumbnail
frame
for
group
sets the thumbnail frame for all recordings of the group at the current position of
the recording (live mode),
or for all clips of the group at the current playhead position (playback mode)

Markers list
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Markers
list: Below the toolbar, there is a list view where you can inspect all markers of the
clip and edit their information or navigate to their marked position or in and out-points:

Rating

allows setting a rating (no rating – 5 stars) by clicking on the stars or using the
associated menu items, keyboard shortcut, or Stream Deck controller actions

Marker
type
allows changing the marker’s type by choosing a type from the drop-down or
using the associated menu items, keyboard shortcut, or Stream Deck controller
actions

Group
marker/Single
marker
allows setting the group state of the marker via the drop-down or using the
associated menu item, keyboard shortcut, or Stream Deck controller action

Note
field
allows adding a text note:

click into the field or use the tab key to enter it,
after typing your desired note text, you can exit the field with the keyboard
shortcut Cmd-Enter

In/Out
and
duration
lets you inspect the marked frame position’s timecode or (for marker ranges) the
in-point’s and out-point’s timecodes and the duration of the range
and jump to the marked frame position or in-point/out-point by clicking on the
reveal buttons after the timecode labels

Contextual
menu: The marker list provides various other contextual menu items via a right-
click on a marker (multi-selection is possible for some items only):

Jump to Marker In
Jump to Marker Out
Cut
Copy
Change Marker Type
Change Group State
Set Rating
Move Marker In to Playhead Position
Set Marker Out to Playhead Position
Remove Marker Out
Remove Marker
Copy Markers to Text

Remove,
copy,
cut,
and
paste
markers

You can remove markers by selecting one or multiple marker(s) in the list and pressing the
backspace key. Furthermore, you can copy, cut, and paste one selected marker to move or
duplicate it to another position in the same clip or to paste it into another clip. There are also
associated menu items and Stream Deck controller actions to remove, copy, cut, and paste
markers.

A “Copy Markers to Text” contextual menu item allows pasting the info of one or multiple selected
markers into a text document.

Note:
Note:
You can customize the marker names of your project in the libraryYou can customize the marker names of your project in the library
settingssettings
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Customizable
toolbar

The toolbar is available in all window layouts and contains buttons for the most common global
actions. You can customize the toolbar with the contextual “Customize Toolbar…” menu item
(right-click / opt-click on toolbar) and drag and drop more actions into the toolbar or change the
position of the buttons.

Customizable Toolbar

There are buttons for the following actions:

Slot
Manager
opens the slot manager window

Play
All
Input
Slots
toggles playback for all input slots

Record
All
toggles recording for all armed input slots

Input
Slot
Mode
switches the slot mode of all input slots (Live/Playback)

Follow
Selection
sets all output slots to follow the slot selection

Force
Live
forces all output slots to the live signal (live slot mode)

Projects (picker)
allows switching the project,
creating a new project,
or renaming a project

Toggle
Layout
allows choosing the window layout:

Main view layout
Input slots (multi view) layout
Library slots (multi view) layout
Output slots (multi view) layout

Video
Routing
opens the interactive video router control panel

Mute
globally mutes audio monitoring and playback

Audio
Meters
visualize the audio level of the current audio signal
an options button lets you open an audio pop-over where you can see the current
audio configuration and set the audio delay

Play
All
Library
Slots
toggles playback for all library slots
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Connected
Slots
visually highlights the connected slots of the currently selected slot (e.g., for seeing
quickly which source/s are configured to an output slot)

Automations
enables/disables all configured automations

Export
(picker)
allows exporting

the current viewer image to disk,
the current viewer image to a custom location,
the current viewer image via AirDrop
images from the selected media items in the library

the clips of the current library view to Final Cut Pro

selected  clips of the library to Final Cut Pro

report (PDF)
metadata (CSV)
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General Settings
Projects
and
media
management

Reeltime allows managing your shoots in separate projects. Each project has its own clip library
that stores all clips you record during your shoot with all clip-based or global metadata you
applied. Furthermore, each project has an individual media management (with project-dependent
media folders and record folder).

Project
management

Using the “Projects” toolbar button, you can

create a new project via a “Create Project” window,
switch to an existing project via a “Manage Project” window,
or rename the current project

Project-dependent
media
management

Media files recorded within Reeltime are stored in a designated “Media Folder”. Each project uses
one media folder as the current “Record Folder.” When you import create new recordings or import
movies, the corresponding media files are saved into the currently set record folder.

Media folders and the current record folder are project-depending settings. Consequently, it makes
sense to use a separate media folder/record folder for each project.

You can set the record folder when creating a new project or change the record folder in the
“Recording” settings. The default parent directory for project Media is “Reeltime Media” in
~/Movies.

Note:Note: The slot and device configuration is a global setting and, hence, not based on the The slot and device configuration is a global setting and, hence, not based on the
project.project.
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Recording settings

Unique
media
folder
references
and
media
status

Each media folder contains a JSON file holding a UUID for unambiguously referencing.

Multiple
media
folders

You can add multiple media folders to the same project. In the media folders table of your project’s
recording settings you can add and remove media folders. One media folder can be made the
current record folder. You can remove all media folders with the exception of the currently set
record folder.

Note:Note: Reeltime detects a media folder by reading the UUID stored in the JSON file of the Reeltime detects a media folder by reading the UUID stored in the JSON file of the
folder. Make sure that the corresponding JSON file always remains in its media folder. folder. Make sure that the corresponding JSON file always remains in its media folder. 

Note:Note: When adding a media folder from another project to your project’s recording When adding a media folder from another project to your project’s recording
preferences and you delete shots and the associated media files within one of the projects,preferences and you delete shots and the associated media files within one of the projects,
the files will be offline in both projectsthe files will be offline in both projects
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Handling
media
files

Delete
Clips:
When deleting clips, you will also delete the associated media file.
Reveal
In
Finder:  A “Reveal In Finder” item in the contextual menu of the clip library lets
you quickly reveal the associated media file of a selected clip in its media folder in the Finder.

Recording
settings

In the recording settings, you find advanced options to customize settings and behaviors related to
recordings:

Media
Folders: You can add multiple “media folders” to flexibly add additional media
storage space. The media folders are a project-dependent setting.

You must define one media folder as the current “record folder”. There can only be one
record folder configured at a time.
Learn more about media folders in the article Projects and Media Management.

Record
Format: You can choose between various codecs of the ProRes family.
Timecode:

You can sync by using the original timecode embedded in the SDI signal (make sure to
jam-sync cameras to create timecode-synced groups using SMTPE timecode).
Alternatively, you can sync multiple incoming signals in your group recording by using
the current time as timecode.

Cancelled
Recordings: You can set whether cancelled recordings should be moved to the
trash or deleted permanently.
Auto
Record: You can trigger start/stop recording based on the record flag embedded in
SDI camera signals.

You can choose between different Trigger Record Behaviours and Trigger Stop
Behaviours (e.g., if you can only receive a record for one camera in your setup, you
can choose that this camera should trigger start/stop recording for all cameras).
If your production requirements allow the use of RecRun timecode, you can choose
that option as an alternative way to use auto record (e.g., if you cannot receive a
record flag via SDI). The RecRun auto record mechanism triggers start/stop recording
based on if the timecode is running or not. Consequently, you need to ensure that all
cameras are set to RecRun timecode.

In the “Behavior After Recording” box, you can set your preferred automatic behavior after a
recording was finished:

Increase
take
number
after
recording
has
stopped automatically increments the take field
after recording (respecting your current slating settings).
Automatically
load
new
clips
for
playback automatically loads new clips for playback into
their source slots.
Automatically
start
playback automatically starts playback after loading the new clips. You
can choose if teh playback should start immediately, or after a short delay of 3, 5 or 10
seconds.

 

Note:Note: Blackmagic capture devices do not support receiving the record flag in HANC metadata Blackmagic capture devices do not support receiving the record flag in HANC metadata
so that auto record via the HANC record flag is only possible with AJA or DELTACAST captureso that auto record via the HANC record flag is only possible with AJA or DELTACAST capture
devices.devices.
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Main
audio
for
recording
and
playback

Reeltime can receive audio input signals from multiple connected audio devices and record the
audio in sync with your video recordings. The input signals are mixed down to one main audio
track, which you can include in any recordings, and simultaneously output to one audio output
device for live audio monitoring or audio playback:

If you have an input slot set to live slot mode, you can monitor the main live audio.
If you select a library slot or an input slot set to playback slot mode, you can hear its audio
playback.

Read how to set up audio devices in the article Setting Up Audio I/O Interfaces.

Mix
down
multiple
audio
input
signals
into
one
main
audio
track

After setting up your audio devices, you can enable multiple channels from multiple connected
audio devices and mix them into one main audio output track.

Reeltime’s audio settings allow selecting multiple audio input devices and mixing their
channels into one dual-mono audio output signal for recording and monitoring:

The “Input Devices” list displays all audio devices connected to your machine and lets
you enable all channels you want to use. Each channel has an individual volume slider.
The “Input Delay” setting allows you to add an audio delay to the audio recording to
keep it in sync with the video signals.

Note:Note: If a device is not configured to 48 kHz, it is displayed in red and cannot be used. If a device is not configured to 48 kHz, it is displayed in red and cannot be used.
However, you can open the Audio MIDI Setup to configure the device to 48 kHz.However, you can open the Audio MIDI Setup to configure the device to 48 kHz.

94

Reeltime Pro 
General Settings

https://kb.pomfort.com/?p=20367


Audio settings with multiple audio inputs

 

Main
audio
output

Reeltime’s main audio is one 48 kHz audio track, a mixdown of all enabled audio input channels.
You can output the main audio to one connected audio output device connected to your machine,
e.g., an audio interface. The main audio is also included in the internet streams to RePro Stream
and Autodesk FlowCapture.

For audio monitoring and playback, you can choose an output device or use the system’s
audio output device.
The audio
meters in the toolbar visualize the active audio in green (for playback), blue (for
monitoring), and grey (if the audio is muted).
There are menu items (in the audio menu) and associated Stream Deck controller actions for
muting
the
live
audio
or
all
audio, as well as an associated global mute toolbar button.

Audio
source
selection

The audio source slot for the main audio can either be an input slot or a library slot:

The audio source selection follows the last selected input slot or library slot:
By default, the “Automatic Audio Source Selection” in the audio menu is enabled

Alternatively, you can pin the audio source to a specific input slot or library slot:
If you disable the “Automatic Audio Source Selection,” you can choose from all
configured input slots or library slots to set them as audio source via a sub-menu.
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Audio source pinned to slot “A”

For all audio menu items there are associated Stream Deck controller actions. For example, you
can use the “Enable/disable Automatic Audio Source” action to quickly change from

enabled = Always hear the input slot or library slot that you select,
disabled = Pin the audio source to the currently selected input or library slot.

Working
with
keyboard
shortcuts

There are a variety of keyboard shortcuts available for commands in the main menu of the
application. Keyboard shortcuts help you to boost your productivity by offering direct physical
buttons to features of the application.

Some shortcuts are already predefined. You can also set shortcuts for selected commands that
you perform quite often in order to memorize the interaction with the application more easily.

To inspect the exact list of available keyboard shortcuts go to
 “Keyboard Shortcuts” in the
application menu. This will open the Keyboard Shortcuts Editor.

Keyboard shortcuts editor

Listing
and
searching
keyboard
shortcuts

The keyboard shortcut editor shows a table with list of all actions in the main menu with their
currently set keyboard shortcuts. You can search the list by typing into the search bar on top of the
table.

Edit
keyboard
shortcuts

To edit a keyboard shortcut:

1. Select “Map Keys” to allow changes on the key mapping list.
2. Choose the command row.
3. To set or modify a shortcut press the key or keys to use as the new keyboard shortcut. You

can use modifiers, numbers, letters and characters individually or in combination.

To remove the associated shortcut permanently press ⌫ (delete / backspace) button.

Close the Edit Keyboard Shortcuts window when you are done.

If you choose a shortcut already assigned to a command, a warning dialog box will be displayed
that shows which command already used the chosen shortcut.
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Alert if a key is already assigned

Select “Cancel” and choose another key for your current command, or select “Reassign” which
removes the shortcut from the old command and sets it for the selected command.

Restoring
sets
of
keyboard
shortcuts

You can reset all keyboard shortcuts to latest version of defaults by clicking “Restore defaults…”.

Exporting
and
importing
of
keyboard
shortcuts

The “Export Keyboard Shortcuts…” menu item lets you export your current mapping to a keyboard
shortcuts (.rtkeys) file to disk. In the same way, the “Import Keyboard Shortcuts…” menu item lets
you import a previously saved keyboard shortcuts (.rtkeys) file.

Clone
system

Reeltime supports transferring its complete system configuration from one computer to another.
You can use this feature if you need to change from one computer to another, or share your
system configuration with another user. Additionally, you can back up your preferred system
configuration to retrieve it as a starting point at any time.

You open the dedicated “Clone System” wizard via the Reeltime Pro / Reeltime Lite > Clone
System menu item. You can choose to “export clone information” to export info from the current
computer or “import clone information” to import info from another computer.

The wizard allows exporting and importing a settings file including all relevant configurations, and
guides you through the process of transferring projects and settings for Stream Deck controllers.

Note:Note: Restoring keyboard shortcuts requires a restart of the application. Restoring keyboard shortcuts requires a restart of the application.

97

Reeltime Pro 
General Settings



“Cllone System” wizard
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Import & Export
Media
import

Reeltime Pro supports importing media, including QuickTime movies and various still image
formats.

Media
import

Use the File > Import Media… menu item, or its associated keyboard shortcut (Cmd-I), to import
media into the library. Note that each media item will be copied into the currently configured record
folder. In the open dialog, you can select multiple files for simultaneous import, and you can also
import movies and still images together.

Supported formats for movies are QuickTime files in any ProRes family codec.
Supported formats for still images are jpeg, png, tiff, heif, or heic.

Automatic
label
assignment

By default, all newly imported media are automatically assigned the “Imported Media” label (grey
label). You can change this behavior in the “Automatic Label Assignment” of the library settings.

Stills
creation

Besides creating movie recordings, Reeltime allows the creation of stills from live or playback
signals.

Stills
creation

With dedicated menu items and associated Stream Deck controller actions, you can create stills

from the currently selected slot’s viewer signal (live or playback mode),
for all armed slots (live mode),
or all slots of the currently loaded clip group (playback mode).

The metadata for stills created from live images is generated using the same rules as for
recordings. Stills created from a playback inherit the metadata of their source clips.

Stills are represented by a still image symbol in the library, in the slot cards, and in the viewer
controls.

Automatic
label
assignment

By default, all created stills are automatically assigned the “Reference” label (yellow). You can
change this behavior in the “Automatic Label Assignment” of the library settings.

Export
reports
as
PDF

You can export reports from your current library view as a PDF document containing the
thumbnails and the metadata of each library item (clip or still), e.g., for documenting your project’s
status or to pass on relevant info to other departments.

The contents of the report are based on the metadata columns shown in the library. You can set
which columns are shown by clicking on the gear icon on the top right of the library.

Note:Note: Other than movie recordings, newly created stills are not auto-loaded for playback after Other than movie recordings, newly created stills are not auto-loaded for playback after
creation.creation.
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To include the in/out ranges info and marker info, ensure to show the “In/Out Ranges Count” and
“Markers Count” columns.

To export a report:

Configure the desired view in the clip library,
and choose File > Export Report (PDF), or the associated keyboard shortcut, or Stream Deck
controller action.
There are also contextual menu items for folders, bins, and smart groups.
Additionally, you can trigger the report export via the export toolbar button.

In the save dialog for the PDF file, you can choose a name and target directory for your file, set
whether thumbnails should be included, and specify whether the PDF should be opened
automatically after creation.

Export
metadata
as
CSV

You can export metadata from your current library view as a CSV file, for example, to import the
metadata into another software or to pass on relevant information to other departments.

The contents of the metadata CSV are based on the metadata columns shown in the library. You
can set which columns are shown by clicking on the gear icon on the top right of the library.

To include the in/out ranges info and marker info, ensure to show the “In/Out Ranges Count” and
“Markers Count” columns.

To export metadata:

Configure the desired view in the clip library,
and choose File > Export Metadata (CSV), or the associated keyboard shortcut, or Stream
Deck controller action.
There are also contextual menu items for folders, bins, and smart groups.
Additionally, you can trigger the metadata export via the export toolbar button.

In the save dialog for the CSV file, you can choose a name and target directory for your file, set the
desired separator/delimiter, and specify whether the CSV should be opened automatically after
creation.

Viewer
image
export

You can export an image file from the current viewer signal in the file formats jpeg, tiff, or heic file
(settable in the advanced settings).

You can choose between three ways to export a viewer image:

Direct
export
to
disk:
File > Export Current Viewer Image exports the current viewer image
directly to disk. You can set the default location for the image report in the advanced
settings.
Export
to
disk
with
save
dialog:
File > Export Current Viewer Image As… opens a save
dialog, allowing you to enter a file name and select the target directory for the viewer image
to be exported.
AirDrop: File > Export Current Viewer Image via AirDrop… allows you to share the current
viewer image with anyone nearby via AirDrop.

Additionally, you can trigger all three viewer image export options via the export toolbar button as
well.
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Library
image
export

You can export image files from the currently selected media items in the library (clips and/or stills),
including the option to export the marker positions of clips as individual stills.

To export images from the library, select the desired media items (clips and/or stills) in the library
and trigger the export via the File > Export Images From Selected Media Items… menu item, or via
the associated keyboard shortcut. Additionally, you can trigger the library image export via the
export toolbar button as well.

An Export Images window lets you choose from the following options:

Export
to
lets you choose the target directory for your image export.
File
Type allows you to choose the image file type for your exported images ( jpeg, tiff, or
heic).
Naming
Scheme
allows you to choose the desired file naming scheme for your exported
images.
Marker
Positions lets you select which marker types of the selected clips should be
included as exported images.

File
Name
Suffix options allow  you to include relevant info from your markers in the
file name of the images:

Marker Name
Marker Timecode
Marker Rating

The Export  button exports the images to disk.
The Export via AirDrop…  button allows you to share the imges with anyone nearby via
AirDrop.
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Export images window with configured export options
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Troubleshooting
Transfer
Reeltime
projects

This article will show you how to transfer a Reeltime project from one machine to another.

Copy
the
project’s
library
folder
to
the
new
computer

Locate the currently used project folder via the “Show Library in Finder” item in the file menu.
Quit Reeltime on the old and the new computer.
Copy the whole project folder (e.g. Project-68684E4EB011) to the same path
(e.g.~/Library/Application	Support/Pomfort/ReeltimePro1/) on the new
computer.
If your project contains LUT filters and/or image overlay filters, you also need to copy the
directories “LUT” and “Overlays” in ~/Library/Application	Support/Pomfort/ to the
exact location of the new computer.
Open Reeltime on the new computer.
Open your project via the project chooser’s “Switch Project…” item and select the copied
project to open it.

Copy
the
project’s
record
folder
to
the
new
computer

If your record folder with the recorded files is on an external hard drive, you just need to eject
and plug out the drive on the old computer and plug in the drive on the new computer.
If your record folder with the recorded files is on the internal hard drive,

locate the project’s record folder by selecting the record folder in the media folders
table of the recording settings and pressing the “Reveal in Finder…” button,
copy the associated directory to an external hard drive,
add the copied record folder in the media folders table of the recording settings on the
new computer.

After adding your media folder to your project, you should now be able to continue working
as before.

Troubleshooting
issues
with
the
software

The
application
does
not
start

If the application does not start due to a crash or hang, you should first try to

unplug all the connected devices and re-open application,
restart your machine

If that does not help, and Reeltime still doesn’t launch on your computer, you can reset the
preferences for a clean restart of Reeltime.

Follow the below instructions to reset the preferences of Reeltime
Pro:

Quit Reeltime Pro
Create a copy/backup of the following file (optional)

Note:Note: The new computer’s Reeltime version should be at least as advanced as the old one. The new computer’s Reeltime version should be at least as advanced as the old one.

Note:Note: Resetting the preferences results in losing your customized settings and slot/device Resetting the preferences results in losing your customized settings and slot/device
configuration. If you want to keep your current preferences, you can rename or copy (andconfiguration. If you want to keep your current preferences, you can rename or copy (and
backup) the preferences; see below.backup) the preferences; see below.
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~/Library/Preferences/com.pomfort.ReeltimePro.plist

The
Library
folder
is
hidden
by
default.
You
can
open
it
in
Finder
by
opening
the
“Go”
menu
and
holding
the
“option”
key.
You
will
see
an
extra
entry,
“Library,”
in
the
“Go”
menu.
Choose
this
entry,
and
a
Finder
window
will
open
with
the
Library
folder.

Open up the Terminal application (type terminal in your spotlight or navigate within the
Utilities folder of your application folder)

Type the following command in your terminal window

defaults	delete	com.pomfort.ReeltimePro

Start Reeltime Pro,
now Reeltime Pro should again start as usual.

If the problems persist, please contact our support team.

Follow the below instructions to reset the preferences of Reeltime
Lite:

Quit Reeltime Lite
Create a copy/backup of the following file (optional)

~/Library/Preferences/com.pomfort.ReeltimeLite.plist

The
Library
folder
is
hidden
by
default.
You
can
open
it
in
Finder
by
opening
the
“Go”
menu
and
holding
the
“option”
key.
You
will
see
an
extra
entry,
“Library,”
in
the
“Go”
menu.
Choose
this
entry,
and
a
Finder
window
will
open
with
the
Library
folder.

Open up the Terminal application (type terminal in your spotlight or navigate within the
Utilities folder of your application folder)

Type the following command in your terminal window

defaults	delete	com.pomfort.ReeltimeLite

Start Reeltime Lite,
now Reeltime Lite should again start as usual.

If the problems persist, please contact our support team.

The
application
hangs,
or
crashes
repeatedly

In the rare case that Reeltime hangs or crashes repeatedly, you can send automatically created
reports to our support. You can do this by:

Choosing “Contact Support” in the “Help” menu of Reeltime.
Enter your personal information (name and email) so that we can get back to you.
Enter a short description:

What steps do you perform in the software that lead to the problem,
what happens when you perform these steps, and
what you would expect the software to do instead.

The form will include crash reports, log files, and system information in addition to your message,
which will help our support trace possible bugs.
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The
video
signals
are
stuttering

Under some circumstances, the application’s performance may not be as good as expected, and
the video in the input and/or output may stutter or show other undesired effects. Try the following
to troubleshoot the issue:

Restart the application
Avoid performing demanding tasks in other applications while working in Reeltime; (if
possible, close applications that you do not need)
If the above steps did not help, restart your machine
Decrease the framerate of the slot previews in the advanced settings

The setting only reduces the frame rate of the slot previews in the user interface. The
image signals in the viewer, and the output signals retain their original frame.

Close the application, unplug connected devices, and re-open the application
Check for a newer driver version of your video I/O devices
In rare cases, resetting the application preferences can resolve the issue (see above)

Troubleshoot
re-connecting
of
Blackmagic
video
I/O
devices

When a Blackmagic video I/O device was disconnected or lost power temporarily, the affected
input and/or output slots will display a ”No Image Source” placeholder image.

If the device did not automatically resume receiving and/or sending the video signals after re-
connecting, and still shows the ”No Image Source” placeholder image or a black video image, a
Blackmagic background process did not restart successfully.

Follow the steps below to manually restart this background process to continue receiving and
sending signals with the device:

Close the application
Ensure the device is connected to the machine and has power
Restart the application
To restart the Blackmagic background process manually, open the Activity Monitor
application and search for “blackmagic”

Select all processes named “com.blackmagic-design.BlackmagiclO.DExt”, press the
“X” button in the toolbar, and proceed with “Force Quit”
The process(es) will be quit but will re-appear immediately
Shortly after you re-started the process(es), the device should resume receiving and/or
sending the video signals in Reeltime Pro as intended

Force quit Blackmagic processes in Activity Monitor

Troubleshoot
issues
with
embedded
audio
via
AJA
video
I/O
devices

Note:Note: Removing devices while the application is running may lead to performance issues; Removing devices while the application is running may lead to performance issues;
therefore, hot-plugging devices is currently not recommended.therefore, hot-plugging devices is currently not recommended.

105

Reeltime Pro 
Troubleshooting



If you encounter problems capturing embedded SDI sound and/or outputting sound to an SDI
monitoring device via the driver of your AJA Io 4K Plus or AJA Io X3, try the following steps to
troubleshoot the issue:

Set the AJA audio device as audio output device in Reeltime’s audio settings
Open the AJA Control Panel and go to “Audio Mixer”
Ensure to set

“Capture Monitor” > “Host Audio (OSX Core Audio)” > “On”
“Playback Monitor” > “Host Audio (OSX Core Audio)” > “On”

Audio mixer settings in AJA Control Panel

Restart Reeltime, so that the new audio configuration takes effect

 

Note:Note: You must also ensure that the audio of your playback or live monitoring signal is not You must also ensure that the audio of your playback or live monitoring signal is not
muted. For example, the audio meters in the toolbar should be colored during playback or livemuted. For example, the audio meters in the toolbar should be colored during playback or live
monitoring.monitoring.
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Known
issues
and
limitations

Known
issues

4K (6G/12G) SDI input/output with AJA Io 4K Plus is not supportedn
Removing devices while the application is running may lead to performance issues; therefore
hot-plugging devices is currently not recommended

Limitations

Interlaced video signals are not supported
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